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Preface 
“Our species thinks in metaphors and learns through stories.” 

(Mary C. Bateson, anthropologist) 

We are surrounded by stories. Stories are deeply rooted in our cultural heritage. They deal with 
daily life, joy, grief, happiness, loss, fear and reflect the many facets of our cultures. Stories 
connect people and help to build bridges across cultures. They are a wonderful way to increase 
cultural understanding, learn a language, be in touch with others and express oneself. 

In the framework of the project LISTEN, Learning from Intercultural Storytelling, a European 
project funded by the Erasmus+ Programme, we used stories and applied storytelling as an 
educational method to enhance a wide range of competences in the work with refugees. We 
explored also ways how radio and other forms of audio broadcasting can be used as medium to 
share those stories and to make them available for a wider public. The manual at hand is one of 
the main products of the LISTEN project. It introduces storytelling as method for adult education, 
and highlights the benefits of the approach and the ways it can be applied. 

It addresses social workers, educators and training providers who provide learning opportunities 
for refugees and migrants and who want to develop new professional competences and skills or 
expand the existing ones. But LISTEN is not only about enhancing competences in the use of 
storytelling and the recording and broadcasting of stories but provides educators also with tools 
to validate their newly acquired competences and the ones of their learners.  

In LISTEN we further developed a well proven validation system – LEVEL5 – especially suitable for 
validating personal, social and organisational competences. Validation can give evidence to 
professional continuous development of trainers, and add to empowering refugees as it makes 
their learning progress and achievements visible and thus increase their self-esteem and 
confidence.  

The manual is based on the expertise of the partner consortium in terms of storytelling and 
validation and on the comprehensive piloting activities carried out in all partner countries. It 
consists of five main chapters: The first chapter provides theoretical basics on different storytelling 
approaches, and presents concrete activities that can be used in various training settings with 
refugees. The second chapter focuses on intercultural understanding and competences, beyond 
the focus on storytelling. It is divided into two units: one that addresses trainers and describes 
activities with which educators can reflect on their intercultural understanding and their role in 
intercultural groups. The other unit presents activities that can be used by trainers to foster 
intercultural understanding in learners groups. The third chapter is dedicated to recording and 
broadcasting of stories and describes technical ways of recording and sharing stories with a wider 
audience through radio or Internet broadcasting. The fourth part presents how the LEVEL5 
method can be applied to assess and evidence competence developments gained through 
applied storytelling for learning. The the last chapter contains relevant recommendations based 
on partners’ feedback from the practice phase and underpinning the tips given in the previous 
chapters.  

We hope that you will discover new methods and ways of learning with applied storytelling and 
that this manual contributes to the introduction of storytelling and validation in adult learning.  
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Storytelling methods for 
working with refugees



Food for thought 

We are surrounded by stories. Stories are in our memories, in our family history, our street, 
city or country. Stories come up when we meet friends, colleagues, neighbours … They 
deal with daily life, happiness, grief, anger, fears and hopes. Stories help us to connect 
with others and to gain trust in each other.  

Stories, or more broadly narrative is known to be a fundamental structure of human 
meaning- making and personal development. J.P. Sartre in ‘La Nausea’ writes: “Man is 
always a teller of stories, he lives surrounded by his own stories and those of others, he 
sees all that happens to him through these stories and he tries to live his life as if he is 
telling it.” By understanding our own experiences as stories among others peoples’ 
stories, we gain the chance to look at our lives from a different perspective. 

Content, language and performance turn stories into genuine products of the culture they 
are based in. Storytelling can help migrants to regain a link with their own heritage and 
identity, using stories as carriers of cultural and historical knowledge and to practice 
listening and speaking skills to contribute to intercultural communication and integration 
by building bridges between people. 

The material builds on storytelling resources developed in previous European projects, 
such as StoryRegions (Storytelling for community development and inclusion), TALES 
(Stories for learning in European Schools) and Sheherazade (Storytelling in Adult 
Education).  

In addition, the team of Swedish trainers from Skellefteå, Malin Åberg and Rose-Marie 
Lindfors (partners in LISTEN) who have used storytelling for learning with migrants for 
many years, as well as the Greek storyteller Stelios Pelasgos, and British storytellers Jan 
Blake and Nell Phoenix have contributed to this collection, for which we are very grateful. 
Additional sources will be explicitly named in the text. 

General objectives of the module and overview of units: 

In this module we introduce to storytelling in education, giving a bit of theory on different 
approaches. We also present activities for the respective areas to be used in various 
training settings with refugees. 

The module consists of five units.  
• Unit 1: Storytelling as educational method to foster learning and integration  

• Unit 2: Creating the conditions for telling stories in a group 
• Unit 3: Building stories – structures and frames 

• Unit 4: Storytelling methods for Intercultural Storytelling 

✴Unit: 4.1: Storytelling methods for language learning 

✴Unit: 4.2 Biographical Storytelling 

• Unit 5: Telling and presenting stories 
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Learning outcomes 

After studying this module you will  

• Be able to apply storytelling in educational contexts with refugees and other target 

gropus. 

• Have an insight to storytelling as method for adult education, and its benefits 

especially for working with vulnerable target groups.  

• Understand what it needs to create the conditions for telling stories in educational 

contexts – what role do atmosphere, light, sounds in the background play. 

• Know how to support people in becoming comfortable and how to help them to 

access their creativity.  

• Know more about stories and how they can be developed, structured and told in 

an appealing way.  

• Have an understanding about the performing aspects of storytelling, like the 

intonation of voice, the body language, or pauses to raise the tension. 

• Know how folk tales and myths can be used for learning. 

 

www.listen.bupnet.eu 0!10



Unit 1 - Storytelling as educational method to 

foster learning and integration 

Introduction 

This unit introduces trainers and social workers working with refugees and migrants to 

storytelling as an educational method. It explains the basic principles and how storytelling 

is part of the creation of our identity, but also presents the different types of applied 

storytelling, their purposes and how to apply them without having to be a professional 

storyteller. 

In the spirit of inclusion, but also because we believe that this material can also be 

applied successfully with other (not only vulnerable) target groups, in the text we refer to 

students, learners or participants, instead of refugees and migrants. This emphasises the 

transferability of the LISTEN material to 

other areas of education and community 

work. 

Theoretical basis 

Defining storytelling 

Storytelling is an ancient art with strong 

bonds with literature, popular and folk 

culture, and with heritage. In LISTEN we 

focus on oral storytelling because of its 

social dimension. The following definition 

by Heidi Dahlsveen and Luis Correia 

explains: 

“Oral storytelling is a non-mediated way 

to tell a story, which implies the co-

presence of teller and listener. Oral 

storytelling only exists while the story is 

being told and it is unrepeatable. […] Oral 

storytelling is about what happens between 

people while they are sharing the story. […] It stresses the experience of the event, where 

we are and with whom. From the tellers it requires the sensibility to find the right 

moment, to choose the story and know how to tell it. From the listener it demands the 
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ability to listen or to participate in the terms the context proposes, to relate to others, 

tellers and other listeners […]. 

The narrator is the person who tells the story. It is not necessarily a storyteller as we 

imagine: anyone able to share an experience can tell a story. In this way, oral storytelling 

demands from those who narrate a certain level of exposition, the ability to share his/her 

own imagery and points of view. For those who are listening to it, it implies the 

acceptance of the other, willingness to engage in different ideas and understandings of a 

shared reality. The fact that the teller and the listener are present and that they 

acknowledge each other as persons who are sharing experiences is one of the greatest 

added-values oral storytelling can offer in terms of social interaction. Oral storytelling is 

fundamentally about human relations”.  1

Storytelling in education 

The power of storytelling as an educational tool and for community building is widely 

recognised. Many aspects of storytelling are close to our daily life, to the way we think 

and (try to) understand the world. Trainers often see the benefits of the ‘technical 

competences’ (speaking, communication skills) tackled through storytelling, but 

sometimes underestimate the social effects and the effect of the alternative thinking styles 

promoted through storytelling. It is very important to bring this into focus as well. The 

connecting power of storytelling makes it a valuable tool and form of communication in 

all areas of life which reasons its universal applicability. 

“The benefits of oral storytelling are as diverse as the stories we tell.”  2

A number of sources have described the benefits of oral storytelling for education :  3

• Storytelling improves listening skills and increases attention spans. 

• It requires active listening and is an activity that brings an immediate reward for the 
listener and the storyteller. 

• Storytelling improves the use of oral language and subsequently also written 
language.   

• It improves understanding of plot, sequencing, characterisation, and other literacy 
competences.  

• It develops visualisation and creativity.  

• It allows students to strengthen their communication and social skills.  

• It enhances self-esteem.  

 Tales manual, URL: https://issuu.com/aldenbieseneu/docs/manual-tales-eng_final1

 Munn, H. D., 19992

 Munn, H. D., 1999, Dunning, 1999, Mundy-Taylor, 20133
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• It establishes a special bond between teller and listener, improving the teacher/
student relation, but also the sense of community among students.  

• It improves literacy skills;   
• It strengthens comprehension;  

• It improves vocabulary, imagination, and logical thinking;  
• It builds critical thinking skills as listeners compare different versions of tales or the 

responses of numerous characters to similar situations;  

• It improves empathy with others and, with others’ cultures, enabling children to resist 
peer pressure and make independent decisions;  

• It improves group dynamics, social skills and reasoning;  
• It is a relaxing activity where the students are not assessed and where the only thing 

required is a willingness to listen;  

• It is a living context for making meaning. 

Many of these benefits relate to the needs of refugees, when struggling to establish a 

new life in an alien society after having been uprooted and displaced from their places of 

origin violently.  

No matter what stories are told, it is possible to recognise pedagogical, personal and 

social benefits from the storytelling practice in education, be it formal or informal. On the 

one hand, it helps to create a motivating learning environment and develops important 

skills. But it also contributes to the students’ personal and cultural self-awareness, being a 

way for them to express their thoughts, ideas, their identity. Finally, it helps to form 

confident individuals who are able to make themselves understood, but who also 

understand and respect the importance of difference, and are willing and able to 

communicate across cultures. 

“We have a profound need to tell and hear stories. It is how we share experience, 

understand each other, and create community. Every conversation is full of personal 

anecdote; every effort to explain shared customs and values needs a tale; every bit of 

wisdom is best expressed by a story. The very way our minds think is the essence of story. 

So to master powerful and effective communication, to engage people and ensure they 

remember facts, or to break down barriers of isolation within or between groups, telling 

stories in some form is essential.”   4

For more on the reasons why stories are told, including an introduction to the benefits for 

meaning, memory and healing, explore the “Call of Story” website's “Why Tell Stories” 

pages at http://www.callofstory.org/en/storytelling/whytell.asp from which this quote was 

taken. 

 Tim Sheppard, URL: http://www.timsheppard.co.uk/story/faq.html 4
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Unit 2 - Creating the conditions for  

telling stories in a group 

Introduction 

Storytelling is a social activity. Thus the social dimension of a group that is to be involved 

in storytelling activities is crucial. Trust and confidence are essential conditions for people 

to open up to others, to dare to tell in front of others. For refugees this is even more 

relevant, as they carry additional burden by being foreign to our cultures in terms of how 

we speak and interact, and how we learn, but also through the stress they have 

experienced that might have caused trauma. From this notion it becomes obvious that 

not enough emphasis can be put on team building at the beginning. The atmosphere in 

the group is the more or less fertile soil on which the subsequent steps will take place and 

from where the competences related to storytelling start to unfold. 

In our rational, scientific world, access to creativity is not always easy, but it can be 

activated through a sequence of steps, addressing our senses and clearing the mind to 

become free for telling and listening. Features of the environment can either support or 

hinder this. The atmosphere in the room, the light conditions or surrounding noises, are 

important factors to consider too. In this unit some recommendations are given how to 

create a comfortable environment to tell stories and how to prepare the learners to open 

up and enjoy. 

Activities presented in this unit have a focus on being easily accessible and fun, based on 

the deep belief that shared laughter is one of the best ways to open up to each other. 

Having fun together opens people to do more things and have more fun. 

Theoretical basis 

The Environment 

Stories can be told magnificently around a camp fire in the middle of the desert or under 

the shade of a tree. On the contrary an amphitheatre, a sports hall or a lecture hall can 

pose problems. Our advice is to seek a quiet and comfortable place for the initial 

gatherings of your group. If your group thrives and feels strong, the environment for 

telling becomes less important. However beginners in storytelling should be protected at 

the beginning, in a space of relative privacy with an atmosphere that allows to open up. 

Often rooms cannot be chosen freely, but even with small things an atmosphere can be 

improved, perhaps with nice pictures on the wall, some plants or lighting a candle. You 
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could involve your group in making the 

place you meet at more comfortable 

together.  

Regularity and stability 

Opening up to storytelling is a process 

that takes time. To support this, it is 

helpful to have recurring sessions, rather 

than single encounters. Storytelling 

sessions should be held in the same 

place on a regular basis, and rituals in 

the group can be established, e.g. a 

fixed sequence, involving a certain 

object, a recurring activity,... This is 

comforting. The sense of reliability is 

shattered in refugees’ lives and they 

seek it. Also the structure of the 

storytelling sessions should offer this. 

Preparing to tell 

When you tell your learners you want to do storytelling with them, some might be thrilled, 

but others will say “I can’t do it”. They might not feel capable of using the language well 

enough; they might think they have nothing interesting to tell, or that they lack 

imagination.  

There are some simple tricks to counter this tendency. Firstly try to avoid talking much 

about storytelling. It is a technical term that may create wrong impressions and 

expectations. Instead of talking about it you should just start with a simple activity that 

involves storytelling, without naming it. 

Another recommendation is to establish a sequence of steps that can be repeated in each 

session, to help people to open up to speaking freely, by addressing different senses and 

competences. This row of introductory activities can become a ritual in your group that 

will make it easier for those participants that will only join in from time to time. Here is an 

exemplary sequence of activities. Each activity mentioned below is also described in 

detail under “learning activities”.  
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Step 1: Preparation and creating trust 

Example: Sit in a circle, so everyone is seen and heard, no one is more important than the 

other. There are pictures in the middle and everyone picks a picture they like and then 

talks about why they like it, why they chose it. The others just listen. This exercise works as 

a trigger and opens up the minds of the participants. 

Step 2: Activating body and soul 

Sit in a circle with one chair less than people in the group. One person stands in the 

middle, asking questions for common features in the group, saying e.g. “Everyone who 

wears glasses changes place.” People that respond to the question have to rise up and 

take a new place. One person will be left without a chair and will then ask a new question 

and the chair changing is repeated. Another exercise is to stand in a circle: One looks at a 

person and sends claps and sounds that he/she has to replicate and exchange with 

another person in the circle, and so on. These exercises get the participants to loosen up, 

forgetting their worries. 

Step 3: Accessing language and 

imagination 

The participants are still in the circle. A 

small bal l is thrown between the 

participants, and together with the ball 

flies a word from the thrower. The receiver 

catches the ball and passes it on with 

another word that he/she associates with 

the previous one.  

Another exercise could be between two 

people, where the first one is asking this 

question: “What do I have in my pocket?” 

The other one answers something 

incredible/unbelievable (the moon, an 

airplane, Mount Everest etc.) and then the 

first person says: Yes, that´s right” and 

then tells a short story about how this item 

got into the pocket. These exercises make 

it easier to access our imagination; it can be totally crazy – and normally makes people 

laugh. 
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Step 4: Creating a story 

In a circle the participants are creating a story together. The trainer starts: “Once upon a 

time there was a …” Person A takes over the story and ends up with the phrase: “And 

every day he/she/it …” Person B takes over and continue the story, with the last words: 

“But one day …” Person C takes over: “And today…“ Person D takes over and ends the 

story.  

Another example: Person A tells person B a story about a memory (on a theme). Person B 

gives the story back where A is a hero.  

A third example: Person A, B and C creates three stories where they change tasks 

(beginning, middle, end). These types of exercises make the person aware of the structure 

of a story, how it is composed, how you can add things to make it more interesting. 

There are numerous other activities that can be done to activate and involve learners with 

all their senses, and to prepare them to successively access their language skills, their 

imagination and their ability to genuinely express themselves. Nevertheless we 

recommend taking the time to let the group open up and helping them to leave behind 

their ordinary patterns of behaviour.  

Hint 

Physical exercises are suitable to loosen up for story-telling. But physical exercises are not 

appreciated in every culture, especially for women. Thus learners might have to first 

become familiar with the idea of participating in such activities. If you start with exercises 

with a low threshold that don’t require too much self-exposure and it is a positive 

experience for the participants, you will slowly be able to practice methods that are 

extrovertly. 

See appendix 2 for exercises and learning activities 

By using the exercises which are described in the annex, you will help participants to 

become comfortable in the group, to release tension and to find their own words. 

• Name dance 

• Black and white photos 

• Imagine 

• I see am 

• Creating stories 
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Unit 3 - Building stories –  

structures and frames  

Introduction 

We have dedicated this unit to telling stories. It provides a bit of theoretical background, 

followed by examples of exercises you can apply in your work. 

There are many ways to tell stories, and many stories to tell. Some people have the talent 

to tell stories in a naturally interesting way. They intuitively know how to create tension, 

how to illustrate with words so the images of the story evolve in front of our inner eyes.  

Stories are part of our everyday life. When we speak with others, we naturally exchange 

stories, but to some we attentively listen, while we have a hard time to follow others. In 

order to explore this bias we firstly look at what a story actually is before presenting a 

number of different structures that can be used for developing/telling a story. These 

structures seem to be deeply rooted in our collective consciousness and we automatically 

recognize and appreciate them. If one wants to be listened to, choosing the right 

structure to present the story may already be half of the way. But firstly:  

Theoretical basis 

What is a story? 

Most dictionaries define a story as a narrative account of one or more real or imagined 

events. Within the storytelling community, a story is more generally agreed to be a 

specific structure of narrative with a specific style and set of characters and which includes 

a sense of completeness. Through this sharing of experience we use stories to pass on 

accumulated wisdom, beliefs, and values.  

You need four main ingredients to create stories. 

• A person: the main character or subject. If we do not have someone through whose 

nose we can smell or in whose shoes we can walk, how can we bring our senses to 

bear on the story? Or, more precisely, awaken the listeners’ memories of their own 

sensory experiences. 

• A place: an environment in which we hear sounds, the sun shines or the wind blows 

cold. 

• A dilemma: a problem. In this lies the crux of why we tell stories, we want to 

understand what it is to be human. Problems come in all shapes and sizes, a shoe 
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lace might snap, a volcano erupt, the stock market crash, or a man says no at the 

altar. 

• An end: What was suggested in the beginning of the story is now being fulfilled. 

Either the dilemma is solved or not. The end reflects your reasons for telling this very 

story. Not all endings are happy, but you should be sure where you want to land with 

your story. It is your place of safety at the end of the journey. 

Each story should have a structure. This structure helps the teller to remember a story and 

the listener to follow and better understand it. There are several well established common 

structures to plot a story. 

The most basic structure – 3 steps: 

• Introduction: here the main characters, the location of the story and the core conflict 

is introduced; 

• Main part: In the course of the story the conflict/dilemma increases until it reaches a 

tipping point and the protagonist experiences his lowest point; 

• End: finally the protagonist solves the problem/conflict and rises again. 

For a four step structure you can go with the ingredients of the story as described above: 

a person, a place, a dilemma or problem and a solution: the end. 

Those four elements can be adapted and additional ingredients can be added – the 

structures expanded. An alternative but quite similar structure would be this: 

• Introduction/Routine – introducing the subject and the environment of the story to 

come, e.g.”Once upon a time in China there was a man, who worked in a factory. 

Every day he took his bike to go to work....” 

• Problem – “One morning the man found his tyres to be flat. He was afraid, as he 

knew he would get into trouble with his boss...” 

• Solution – “He took the bus to work, where he met a very nice young woman and 

they fell in love at first sight...” 

• The moral/lesson to be learnt: “Take problems as chances. You never know what 

comes across when you break your routine.” 

Another similar structure consists of 5 steps: 

• Place and situation 

• Relationship 

• Problem/conflict 

• Solution 

• Moral or consequence 

www.listen.bupnet.eu 0!19



Finally a basic structure to tell fairy tales: 
• Once upon a time – the situation (e.g. Hänsel and Gretel were two children from a 

very poor family) 
• A problem comes up/unsatisfied need (e.g. Their parents didn’t know how to feed 

them so they lead them into the forest.) 
• The main character tries to solve the problem. For this a conflict/struggle evolves 

(e.g. Hänsel and Gretel trying to find their way home from the trace of breadcrumbs, 
but as birds have eaten them they get lost anyway) 

• Solution/gain 
• Change/insight 

There are more complex but also very familiar structures for a story. One is the so called 
hero’s journey. An example of this would be Tolkien’s “Lord of the Rings” or “Star Wars”, 
where a hero goes on a journey that transcends him. 

How to apply these structures? 

To start with, each of these structures can be filled with one sentence only for each of the 
steps. You will be surprised to see that it works, even if the story is very short. But of 
course each element can be told with more than one sentence and more complexity.  

Once we have a basic structure to tell a story (the bones) we need to put flesh to it. Two 
basic techniques can be applied to make a story more vibrant. 

Advance and extend 

The terms advance and extend refer to the two dimensions in which a story is told: the 
development of the plot (advance) and the atmosphere (extend). Extend means that one 
stops to further develop the plot and focuses on the situation, which is then described in 
some detail. This includes elements of the environment, but also sensational and 
emotional aspects. With the extend technique atmosphere can be created so the listeners 
develop pictures in their minds eye. 

Action – Emotion – Details 

Similar to the advance-extend technique, the teller balances the elements in the story that 
refer to plot, emotions and (atmospheric) details. 

James Cameron (Avatar) sums it up as follows: “You think of some good characters and 
you have them do some cool stuff that you can relate to and go through hell and come 
out the other side of it, changed in some positive or negative way, and it ends.” 

See appendix 2 for exercises and learning activities 

• Storyboards to plan a story 
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Unit 4 – Storytelling methods for  

Intercultural Storytelling 

Introduction 

In the following, we present a series of storytelling approaches specifically designed for 

working with refugees and migrants. Some are useful for learning languages, others focus 

on the life stories and new perspectives that begin as inner stories that we tell ourselves. 

Becoming aware that we keep telling stories to ourselves is already a strong approach 

that empowers us and can trigger change. Here we give an overview of the field and the 

reasons for the benefits, the actual activities and exercises are described in the annex. 

Storytelling methods for 

language learning 

There are many storytelling based 

activities for promoting a dialogue and 

thus for applying language. Games such 

as “Gossiping”, “Interrupter” and 

“Fortunately/Unfortunately,” all have this 

purpose. Gossiping, for example, is a 

humorous exercise where people sit in 

duos and extemporize on a story they 

have all listened to, filling the gaps by 

gossiping (e.g.: “Have you heard what 

Snow White was up to recently? Living in 

a commune with these seven strange 

men, apparently they were in the 

diamond trade…”). In the activity, 

“Interrupter,” there is one main 

storyteller who improvises a story and 

several interrupters who occasionally interrupt with an unrelated word that has to be 

incorporated into the story. Similarly, “Fortunately/Unfortunately” is a group storytelling 

activity. One person starts improvising a story and speaks for about a minute (or as long 

as it makes sense). He ends his part of the story with “fortunately…” or “unfortunately…” 

and the next person takes over the story. 
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Biographical Storytelling 

On the next pages we explain how to work with people’s own life stories. You will get 

examples of different ways to start a process to find a life story worth telling. The use of 

real life stories in group trainings requires some additional considerations compared to 

the activities described before above. On one hand, sharing one’s own experience brings 

people together, because shared stories help to identify with one another. On the other 

hand, we like to keep certain stories to ourselves, and if they become known, we feel 

ashamed and vulnerable. This is 

especially the case for people who have 

stories of great hardship on their minds. 

Thus certain preconditions should be 

met. 

The most important thing is to create 

trust in the group, so that each 

participant knows that they can rely on 

the trainer as a leader, feel safe and trust 

on the other participants’ goodwill. They 

need to know that it is okay to cry, to 

laugh, to be calm, to show feelings or to 

be vulnerable. They also need to feel 

that they are in a safe place, that people 

in the room want everyone to succeed, 

and that diversity is the norm.  

As a trainer you need to have access to 

your own vulnerability, your own tears, 

your sadness, your joy. You need to have 

very good listening skills and need to be present. You also need to be flexible, open 

minded, and curious. 

You must be clear with the purpose of your activity and the object. It is also good to have 

knowledge about cultural backgrounds of the learners that provides understanding and 

knowledge about sensitive aspects and whom to contact if they need help because a 

story stirred up old pains. And most important is to have a genuine interest in listening to 

peoples’ life stories.  
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Theoretical basis 

Stories have always been part of us 

It began with oral tradition, dancing and singing. Then we created cave paintings and 

stories were passed down from generation to generation. Now we live in a world full of 

books, pictures, movies, theatre, dance, YouTube, and Facebook and continue the 

storytelling.  

Stories give us answers to what it means to be human. We can share memories and 

experiences, develop ideas about the society we want to live in, and talk about things we 

dream of and long for.  

Whether the stories are verbal or printed, we use words, rhythm and empathy to paint 

images of places, people and events. The narrator or writer allows the listener to create 

their own version of the story in their mind. As a storyteller you are the instrument of the 

story. 

A process for finding and telling life stories 

1. Theme: “The first time I … “ 

Start in a circle. Present a number of pictures with different scenes. Ask participants to find 

a picture they like (one for each). Ask: “Tell us why you choose the picture, what is it you 

like in it.” Listen to every story.  

Warm up the body and voice: The participants sit in a circle, one person stands in the 

middle, wanting a chair. The person in the middle says:   “Everyone who likes coffee 

changes places” and while people are changing places, the one in the middle tries to find 

a place to sit. When everyone is sitting there is a new person in the middle who says 

“Everyone who … “ This helps to arrive in the presence of the moment and to laugh 

together. 

Explain: What is a story? A story can be made from: When? Where? Who? What? (Why?) 

And how does it end? In a story we can share experiences, hopes, dreams, fears.  

Ask participants to think of “The first time I… “. Do an inventory on the board, from what 

people already know. Do a list of all suggestions and experiences.  

Then every participant can choose one item from the list that is related to their own life. 

When was it? Where was it? Who was in the story? What happened? How did it end?  

Let participants tell their story about a “first time” in pairs. Instruction for feedbacks: Give 

response that has to do with what you liked in the story, and what you liked about the way 

it was told. Ask the group for volunteers to tell the story in front of the whole group. 
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2. Theme: “Ups and downs”  

Ask participants to find a memory from their life that made them feel either good or bad.  

Have them draw a picture on a big paper about that memory, to draw the place, the most 

important objects/persons/animals that are in that story. Ask them to also draw 

themselves in the picture.  

Work in pairs: Ask them to retell the memory by naming the things they drew. E.g.: “this is 

the tree were I was hiding. This is the door 

that my father opened. This is the dog that 

was sick. “ 

Next let them tell the story in pairs, this 

time it will be told as a story, so before 

telling it, they must decide how it will start, 

what is the opening sentence? Who is in it? 

  Where does it take place? What is 

happening? How does it end? What is the 

last sentence?  

In pairs participants listen to the partners’ 

story and give response to each other:  

“What did you like in the story? What did 

you like in the way it was told? Do you have 

a question to the teller or to the story?” 

Ask who volunteers to tell the story to the 

whole group, including the responses they 

got. Finally everyone gives positive 

response to the teller and the story.  

3. Theme: “Dreams“ 

Warm up exercise “You don´t know what I have got in my pocket” as described on page 

30. 

Prepare a collection of random objects (e.g. a button, little animals, a pen, a beed, a 

flower, ...) and put them on a table.  

Ask participants to choose three objects that are related to dreams they have had during 

their life.  
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Everyone then creates three short stories and uses what they already learned about how 

to create stories:  

To see the story, to be in it: “Sit on a chair, close your eyes, imagine the start of your story, 

be in the same place, feel it again, see the persons involved in your mind, hear, smell, feel 

what was going on. Be in the story, in your memory, like in a film, walk in the film with 

your senses open, record it once more. Open your eyes, and come back to this room.” 

Participants sit in pairs, each one puts the objects in front of themselves on the floor. They 

decide who will start. The partner points at one of the objects and the partner starts 

telling that story. The other person says thank you for the story and now it is the partners’ 

time to tell. 

Talk about how or if imagination can help to 

remember true life stories. And how 

imagination helps us to tell from what we 

saw and experienced.  

4. Theme: “Me, a hero” 

Work in pairs: All participants choose a 

picture from a collection with different 

images that fits to their own hero story – a 

story of when the participants did 

something that made them feel like a hero.  

Let them tell it to their partner, about the 

place, the persons that were involved, the 

feelings, the plot. And how did it end? 

  They should listen very openly to each 

other's stories. 

Then let them swap the stories and let the 

partner tell it again, as if it was a story about a hero.  

Reflect in the big group: how was it to be a hero in your own story. Ask: “What was it like 

to hear you own story? What do you take home from this session?”  

Deepening the stories  

Now participants have a number of personal stories in their minds. It is time to work on 

the stories a little more, before telling them to a larger group, on the radio or any other 

context they want to tell them in.  
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Most important is the dramaturgy: where are the most important “rooms” in the story? 

Where are the most important thresholds that take the story further? What makes it 

interesting to listen to?  

Participants choose one of their stories and continue working on it.  

They select five objects from a box and bring the story into five "rooms": one object 

symbolizes the beginning that takes place …?. After that come the three parts where the 

most important plots are (Where is that happening? In the wood? In the truck? At the 

sea?). The last is the end, and where is that happening?  

What feelings are associated with each "room"? Who is in these "rooms”? 

Can you see what takes the story forward? What does not take the story forward, should 

be maybe dropped. 

The participants present to each other the five “rooms”, in which the story lives. They tell 

the story by saying what is happening in each room:  "this is the kitchen where the girl is 

sitting all alone, crying at a fireplace 

The participants reflect on what this exercise gave them and take a moment in peace and 

write down what you they to remember, what they need to keep and take care of.  

They tell their story in smaller or bigger groups give / get feedback on what they have 

heard and focus on: 

 This is what I like about your story.  

 Strongest picture in the story 

 This is what I think your story is about 

 This I will give you as a storyteller.  

After the session, you should meet and reflect together on how it was to tell their story, 

what they experienced, what thoughts they have after doing it. Did they get any response 

from the partners? What did they see in the eyes of the listener? How do they feel 

themselves? 

See appendix 2 for exercises and learning activities 

• Silent Books 

• Story and Truth 
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Unit 5 - Telling and presenting stories 

Introduction 

Storytelling is not only a common form of interaction when people meet, but also an art. 

In ancient times these artists were the bards. This special form of storytelling can also be 

used in education, but it requires some prerequisites and competences from the teller. 

But you must not be an ancient bard to tell stories! It’s easy to tell stories!  

Theoretical basis 

At this point, we would like to address this special form of storytelling and those who 

want to learn more about it. There are numerous databases with stories from all over the 

world. Performance skills are similar to those actors use.... 

Nevertheless, you may find a story that has a message you feel you should share with 

your learners. For this purpose it is helpful to keep some recommendations in mind. 

Recommendations for new storytellers 

• People have been telling stories for thousands of years. The art of storytelling will 

never die. You tell stories every day. Maybe you have already noticed how easy it is 

to capture the listeners. You can do it. 

• Rehearse: Tell the same story over and over again. Find people to listen. The story – 

and you – will change as the story becomes more and more yours. Through 

rehearsing you will find yourself more secure in storytelling and more able to 

embroider it in your own way. 

• Select stories intuitively: The story that you are instinctively attracted to is your story. 

Or the one you find yourself marvelling at, or the one that keeps pestering you 

without you knowing why. Allow a story to choose you. Be sensitive to the logic of 

the story and understand what you want to say with the story. Change it so that it 

suits you – but without changing the structure. Make the story your story. 

• Distinguish "the bones" of the story: The story has a plot – a skeleton that is 

independent of the setting or the context it had when you found it. Expose these 

“story bones", maybe through short notes or bullet points in drawings or text. Then 

fill out the skeleton with new flesh: your own settings, your details and your 

interpretation of the idea. 

• Do you really need to maintain the structure of the old stories? Traditional material 

belongs to us and we can do what we want with it. But there are very good reasons 

to respect the material that has been handed down for centuries - sometimes 
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thousands of years. Many stories are not understandable until you start telling them. 

These stories were never intended to be literature. 

• Storytelling is a visual language: a language of the senses. Imagine you go from 

place to place in the story: what do you see? What kind of light is there in each 

place? What time of day is it? How does it smell? What you see and experience with 

your senses allows the listener to experience the story in their mind’s eye. That is the 

trick. 

• Memory techniques: to really see the story, scene by scene with all its details, is the 

way to remember stories of all lengths. See and experience them as if they are 

places you have been to, not something abstract you have memorised. 

• Oral storytelling is not text: It is never about learning a text by heart. A text may 

have been the source for a story, but put it away as soon as possible and begin to 

tell it orally. 

• Beginning and end: be clear on how to start your story and how to end it. These 

allow you to safely move around as you want, in between them. In the beginning 

and the end of the story is also found its meaning and your ideas - what you want to 

say by telling it. The end ties together all the strands that you started unravelling at 

the beginning. 

• Warning about explanations and using more abstract language: You will see right 

away that you do not have the listeners with you that they quickly get tired. It is the 

images that enthral, that are the real storytelling language. The sooner you can give 

them the first image at the start, the better. And let the story end in silence rather 

than attempting to explain it. Stories speak for themselves; that is part of their 

magic. 

• Being a storyteller is not a role: The storyteller is you, and the story comes from 

within you. You have chosen it and made it yours, or you have created it. It is this 

that makes storytelling unique. The meeting between the narrator and the listener is 

genuine and authentic. Therefore, everything should be as much you as possible; 

your voice, your accent, your gestures, and your posture. 

• Ask someone to listen: Skilled and loving criticism is gold. Start a storytelling group 

where you will listen and give each other feedback. 

• The lie is a friend who can tell a deeper truth than cold reality. This is the secret 

behind all cultural expression. Storytelling is always subjective. "A good lie can go 

from Baghdad to Constantinople while the truth is looking for his sandals", as the 

Arabic proverb says. 

• Who can say what truth is? Did you have a mean grandmother who never would 

have told you a story? If you want to weave one into your story, then invent a new 

one. It is never too late to have a happy childhood. 
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• But there may of course be facts you want to convey, absolutely. Nothing is more 

appropriate than weaving facts into a story. Wrapped up in a story, facts are far less 

forgettable. 

• When to speak truth and when to lie? 

It is most important to clarify the 

purpose of your presentation. What 

do you want to achieve? Fact is no 

end in itself, nor fiction. They are your 

tools. 

• Storytelling is communication: Eye 

contact is important; you read in the 

eyes of the listeners how you should 

angle the story. How your listeners are 

placed is important, a horseshoe set-

up all on the same level is ideal. The 

room should have regular, uniform 

illumination, not salon darkness as at 

the theatre. The meeting with the 

other listeners is part of the magic. 

You can develop the communication 

and pull the listeners into the story in 

different ways; with looks and gestures, direct address and improvised editing. It 

strengthens the contact and makes listeners even more alert. 

• Your story is changing and becomes a little different for each new listener. Good that 

is, just as it should be. 

• Storytelling is created together: the listeners are not passive recipients. On the 

contrary, they are working hard to create the world you evoke. The meeting of the 

teller and listener in storytelling is creative and energising. But, beware, show 

respect for the listeners. They remain attached because they accept the contract 

between you in the situation (or because they are forced). The power of storytelling 

is strong: the narrator has the power to manipulate the listener's inner imagery. Be 

aware of it and make sure that your listeners feel comfortable. 

• Forgotten something in your story?: No problem, you can change the story, and it 

will most likely still work. Probably no one has noticed. Or ask the listeners - they will 

surely help you willingly and quickly, once they are inside the story. 

• The response from the listeners is a receipt of your storytelling. Did you not catch 

them? If so, don’t say to yourself “Oh, they weren’t interested”. Instead say: “Oh, I 

want to become a better storyteller.” 
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• Nervous? It is not visible. No one knows about it except you, so do not talk about it. 

Breathe calmly and use the energy in the tension, it gives you focus. 

• Be proud of yourself. It is infectious. It evokes respect. Everybody needs meetings 

with people who stand for what they convey, with good self-esteem. If you get 

applause, receive it happily. 

• What can you tell: parables, wisdom stories, fables, jokes, anecdotes, fairy tales, 

myths, old legends and urban legends – all constitute traditional material that has 

passed from mouth to mouth for centuries. It is yours; you own it together with all 

people of the world. It is an inexhaustible treasure, but makes the story your own; do 

not copy the details.  

•  Your own memories, experiences, observations, life stories and family stories. This 

is perhaps the most important treasure of untold, unique stories. But be personal, do 

not be private. 

•  Site history: What has happened here? Are there site-specific stories like tales, 

ghost stories, and anecdotes? And 

what are the stories about your school, 

your work or your company?  How was 

it born? How did it overcome crises? 

What stories are in its successes? What 

anecdotes reflect its soul, purpose or 

vision? What values do you want to 

convey? Maybe you have a story about 

an object and its history. You can 

convey an interpretation of all this with 

your storytelling.  

• Literature and author-written fairy 

tales: If the author is alive, you need to 

ask for permission. Beware that if there 

are storytellers who tell their own 

stories, they may have copyright.  

•  Facts: to weave facts into a story is fun and effective. Just do not forget the recipe 

for a story. Even a stone can be the main character; you just have to give it some 

human characteristics.  

•  Make stories by yourself: anything can become a story. Let your imagination run 

free and pick up whatever comes to you.  

•  What you tell need not be in any way remarkable, unique or ingenious. Quite the 

contrary, tell with joy and dedication, that's enough. That's the best. 
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Exercises from Unit 2 - Creating the 

conditions for telling stories in a group 

The activities presented in this unit are easily accessible and entertaining, based on the 

deep conviction that shared laughter is one of the best ways to open up to one another. 

Having fun together opens people up to do more things and have more fun. 

Name dance 

Objective Warm up (both body and mind), learn the names

Competences 

involved

Flexibility 
Ability to remember

Description, 

Step by Step

All participants will stand in a circle. The leader begins and says his/her 
name and then makes a movement, any movement, big or small, with 
just one part of the body or the whole body for example a spin, a kick, a 
clap, a wave with the hand, a nod etc. All participants should then 
repeat, together with the leader, and say his/her name at the same time 
as they perform the movement. After that it is the person standing to 
the left of the leader to say his/her name and make a movement. 
Everyone in the ring then repeats both the leader's name and 
movement and the second person's name and movement. Person 
number three continues by saying his/her name and makes a move. 
Everybody repeats etc. When all the participants in the ring have said 
their names, and made their movements it is time for the group to 
"dance". Repeat the names and movements a few turns, increase the 
tempo if you want. Finish by "dancing" one round without talking, 
without saying the names, and just make the movements.

Learning 

Outcomes

Participants will: 
• Get to know each other 
• Get access to their joy and creativity

Additional 

comments
—-

—

Material
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Black and white photos 

Depending on the group size

Duration

Group. Standing in a circle.

Setting

If you are many participants you can let two or three persons say their 
names and make their movements before you ask the group to repeat, 
and then go on with two or three more participants and repeat and so 

on.Tips

Objective To break the ice, to feel confident to speak in front of a group

Competences 

involved

Active listening 
Curiosity  
Expression in a foreign language

Description, 

Step by Step

Lay out many different black and white photos. 

Invite participants to view the photos and select a photo they like.  

Everyone takes the selected photo with them to their chair.  

Participants tell about their chosen photo – why they chose it, what they 
like about it, what it reminds them of, etc. Now is the time to listen to 
each other.

Learning 

Outcomes

Participants will: 
• Express themselves in front of a group 
• Use their language skills to talk about something they are familiar 

with 
• Gain confidence in the group 

Additional 

comments

The invitation to search for a photo that tells about something can be 
used in a million different ways. It can be a picture that tells about: 
winter, summer, fear, dreams, animals, hidden treasures, magic moments 
….
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Imagine what I have in my pocket 

Black and white photos

Material

30 minutes to 1 hour or more

Duration

A group

Setting

Be open to what the participants want to tell

Tips

Objective To create and tell stories from imagination

Competences 

involved

Imagination and creativity 
Self-expression 
Expression in a foreign language

Description, 

Step by Step

The group is sitting in a circle. The leader tells the group that we are 
going to tell stories made up from something that is in your pocket. And 
what is in the pockets will be something very big that is not possible to 
carry in a pocket, but as we are working with imagination everything is 
possible.  

Person no. 1 starts by saying to the person sitting to the right (no. 2) 
“you don’t know what I have in my pocket”.  

The neighbour no. 2, replies “Yes I do, you have a ....” and comes up 
with something big that would really not be found in anyone’s pockets.  
No. 1 then replies: “That’s right, and I have it there because ….” and 
makes up a story about why it is there.  

Then it is time for no. 2 to say to no 3 “You don’t know what I have in 
my pocket?” Continue the whole circle around. 
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I see, I am 

Learning 

Outcomes

The participants will: 
• use their imagination to talk freely 
• express themselves in a foreign language

Additional 

comments

Leads to many funny stories that encourage joking and laughter. The 
theme can easily be changed: Things that live in the sea. Things that 
can fly in the air. Things that are found in the forest, etc. 

—-

Material

30 minutes depending how big the group is.

Duration

A group in a circle, on chairs

Setting

It´s good to show how works in the beginning, so participants can be 
free from the beginning.

Tips

Objective To learn more about oneself and the current mood/ situation

Competences 

involved

Self-reflection, self-awareness, imagination 

Expression in a foreign language

Description, 

Step by Step

Ask the participants to write down the numbers 1-10 below each other 
on a piece of paper. Then tell them to write “I see” after every number. 
This will be the beginning of ten sentences that the participants will 
continue to write.
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Description, 

Step by Step

Tell the participants to go outside for a while, if possible, to have a look 
and write down things that they see, for example: I see a bridge. I see a 
sun. I see a man walking his dog. I see trees. If it is not possible to go 
outside you can also look out through a window and write down things 
that you see, both on the outside and on the inside. For example: I see 
a lamp. I see lots of books. I see snow. 

Then gather the participants again and ask them to change the verb 
“see” in all their sentences to “am”! So now it says, for example: I am a 
bridge. I am a sun. I am a man walking his dog. 

Ask the participants to choose five of their sentences that they think 
describes them in some way and tell/explain to the others why they are 
a bridge, a sun, a man walking his dog etc.

Learning 

Outcomes

The participants will: 
• talk freely and open their imagination. 

Additional 

comments
—-

Paper, pencils

Material

30 minutes

Duration

A group

Setting

It can be beneficial to start working in pairs before you share it with the 
whole group.

Tips
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Creating stories 

Objective To create a story

Competences 

involved

Questioning  

Active listening 

Creativity

Description, 

Step by Step

The leader starts by saying  

1. “Once upon a time, there was a …” – Who is the story going to be 
about? And the person who is asked can decide who the story is 
about.  

2. Where did that person live, and with whom? The next person 
answers that question. The leader can deepen the start of the story 
by asking more about the main character and the place.  

3. “Every day….” What was done every day? The third person can tell 
about this. 

4. “But one day ...” What happened then? So the fourth person can 
continue the story, built on what the others already said.  

5. “So today …” What are the consequences of that? This is the 
ending, told by the fifth person.  

6. What can you learn from that? And a conclusion made by the sixth 
person.  

This story is told in front of the whole group. If you are making stories in 
a smaller group, you can retell the story you made to the whole group.

Learning 

Outcomes

The participants will:  
• know the structure of a story 
• know elements that should be part of a story 
• tell stories together with their peers

Additional 

comments

Since no one knows what the story will look like, you can openly and 
curiously ask each participant questions that will allow everyone to 
answer and contribute to the story.  

Everyone in the group can listen to the stories that are created and can 
be inspired by them.
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—-

Material

30 minutes or more depending on how big the group is.

Duration

Can be made in a group by people sitting in a circle. It can also be 
made in smaller groups of 4 people, or in pairs.

Setting

The trainer is the one who is asking questions, the participants 
contribute to the story.

Tips
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Exercises from Unit 3 

Building stories – structures and frames 

Introduction 

We have dedicated this unit to telling stories. This unit provides a bit of theoretical 

background, followed by examples of exercises you can apply in your work. 

There are many ways to tell stories, and many stories to tell. Some people have the talent 

to tell stories in a naturally interesting way. They intuitively know how to create tension, 

how to illustrate with words so the images of the story evolve in front of our inner eyes.  

Stories are part of our everyday life. When we speak with others, we naturally exchange 

stories, but to some we attentively listen, while we have a hard time to follow others. In 

order to explore this bias we firstly look at what a story actually is before presenting a 

number of different structures that can be used for developing/telling a story. These 

structures seem to be deeply rooted in our collective consciousness and we automatically 

recognize and appreciate them. If one wants to be listened to, choosing the right 

structure to present the story may already be half of the way. 

Exercises and learning activities 

• Storyboards 

Storyboards 

Objective
To structure stories, to visualize them, to convey the actions and 
emotions of the story.

Competences 

involved

Creativity  
Dealing with more complex stories 
Ability to remember

Description, 

Step by Step

When you are going to work with your oral story, you can use 
storyboards that are a powerful way of visually presenting information 
and structuring your story. It also helps you to focus on the different 
parts of your story, beginning, middle and end, and check that your 
action is progressing and to work with descriptions of different kinds - to 
bring in the different senses of your story. You can find many ready-
made templates of storyboards on the internet or create your own.
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Description, 

Step by Step

1. Start drawing your story in pictures from beginning to end. NOTE! 
Write nothing! 

• How does your story begin? 
• Which persons are there? 
• What happens in the story? 
• How is the action forwarded with the help of the pictures? 

2. Look at the pictures and then tell your story once. 
• Is there any superfluous picture that does not need to be included 

or that can be "collapsed" with any other picture? 
• Do you need an additional picture with important information for 

the story? 
• What picture is the most important one for the story? 

3. Look at the pictures again! You should now focus on descriptions and 
different senses. Work with one picture at the time and answer the 
following questions: 

• What do you see? 
• What do you hear? 
• What do you smell? 
• What do you taste? 
• What do you/ or the character of the story feel? 
• What do you/ or the character of the story think? 
• What do you/ or the character of the story want? 

Think about what's important to tell/describe for your story! Write down 
support words in the pictures or below them to remember! 

4. Then tell your story once more by looking at your storyboard. 
This also helps you to remember your story. Try to learn/remember your 
story in pictures or as a movie in your mind.

Learning 

Outcomes

Participants will: 
• learn a method to structure and  
• visualize their history in order to better memorize it.

Additional 

comments

Tell the participants that they don't have to be good at drawing. They 
can also draw stick figures if they wish, as long as they understand the 
meaning of their own drawings.

Templates from the Internet / or your own storyboards 
Paper/Pens

Material
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On the next page you can find a template for a story board that you can copy for you and 
your learners. 



Min. 30 minutes (depending on group size) Individual

Duration

Group

Setting

You should make it clear that it is not about being able to draw.

Tips
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Exercises from Unit 4 
Storytelling methods for Intercultural Storytelling 

Introduction 

In this chapter we present a range of storytelling approaches that are specifically suitable 

for the work with refugees and other migrants. Some are specifically suitable for learning 

languages, others focus on the life stories and new perspectives that start as inner stories 

we tell to ourselves. Becoming conscious that we tell stories to ourselves all the time 

already is a powerful notion that empowers and can trigger change. 

Unit 4.1: Storytelling methods for language learning  

There are many storytelling based activities for promoting dialogues and thus for applying 

language. Games such as “Gossiping”, “Interrupter” and “Fortunately/Unfortunately,” all 

have this purpose. Gossiping, for example, is a humorous exercise where people sit in 

duos and extemporize on a story they have all listened to, filling the gaps by gossiping 

(ex: “Have you heard what Snow White was up to recently? Living in a commune with 

these seven strange men, apparently they were in the diamond trade…”). In the activity, 

“Interrupter,” there is one main storyteller who improvises a story and several interrupters 

who occasionally interrupt with an unrelated word that has to be incorporated into the 

story. Similarly, “Fortunately/Unfortunately” is a group storytelling activity. One person 

starts improvising a story and speaks for about a minute. He ends his part of the story 

with “fortunately…” or “unfortunately…” and the next person takes over the story. 

Exercises and learning activities 

• Silent Books 

Unit: 4.2 Biographical Storytelling 

Introduction 

In this sub-unit you will get examples of how to work with people’s own life stories. You 

will get examples of different ways of starting a process for finding a life story.  

Exercises and learning activities 

• Story and Truth 
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Silent Books 

Objective
To promote dialogue and exchange, to reflect on one's own 
experiences, feelings and events.

Competences 

involved

Expression in a foreign language 
Creativity 

Self-reflection 
Active listening

Description, 

Step by Step

1. Place the participants in pairs and give them these instructions: 
• I will give you one book that you will read together. You have 

about three minutes to finish it. But do not open the book until I 
say so. 

• Please be silent the whole time while reading the book. Do not 
speak to each other. 

• Make sure that you look at every page.  
• When you are finished reading the book, close it and continue to 

be silent and wait for the others to finish as well. 
2. Let the participants read the book in pairs. (Two persons share one 

book!) Give them 3 minutes. 
3. After three minutes you tell the ones that haven´t finished the book 

to do so and when everyone is ready you ask them to share their 
thoughts in pairs. 

4. Now ask the pairs to choose one word that describes the book and 
share that word with the big group.  
There is a clip on Youtube that explains the principle of the book:  
https://www.youtube.com/watch?v=6F02t8LkOXk   

5. Ask the pairs to choose one of the pictures in the book that they 
both like.  

6. Ask them to tell each other what they see, hear, smell, taste and feel 
(what they feel with their body/hands but also in their hearts)  

7. Use the task: Once upon a time and construct a story with the help 
of the sentences. Find inspiration in the chosen picture. 

8. Instruct the participants to sit together with another pair and tell 
each other the stories you have constructed. Talk about new words. 

9. Discuss in the groups of four: Are you familiar with these places? Do 
they remind you of something? (Places you have visited, people you 
have met, feelings that you have felt?)  

10. Hand out laminated pages from the book. Instruct the participants 
not to show their page to anyone else. They will now mingle in the 
room and ask each other: What do you see in your picture? And 
from the information given they will place them self in the right 
order so when everybody show their picture, every page comes in 
the right order. If there are less participants than pages of the book, 
just use a part of the book, maybe the beginning, the end or a part 
in the middle somewhere.
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11. After this the participants can continue working with the book, e.g.: 
• drama/theatre and make up/improvise short dialogues or 

happenings inspired by the pictures in the book. 
• write dialogues, stories inspired by the pictures in the book 
• add music to the pictures 
• talk about their own experiences from life inspired by the pictures 

in the book 
12. Think about/discuss: If you think about your own life right now and 

“zoom in”, what will you find? And what if you “zoom out”?

Learning 

Outcomes

The participants will: 
• learn new words, grammar, narrative structures 
• know the other students’ life experience, countries, cities, places, 

people etc. 
• reflect on their life.

Additional 

comments

There are many books that can be used as silent books. They are 
characterized by the fact that they use very little or no text in addition to 
pictures. So they can be used with learners from different cultures and 
language areas. A beautiful example is Zoom by Istvan Banyai. 
You can read the book from both directions! You can both “zoom in” 
and “zoom out”. 

Manual on the use of silent books: https://www.dropbox.com/s/
bxlxurymus7is6j/Silent%20Books%20ENG.pdf?dl=0 

Silent Books handbook in English 
Books with pictures and no text

Material

Strongly dependent on whether you want to perform all the steps. Min. 
30-45 minutes. 

Duration

Couples, smaller groups

Setting

This exercise is particularly suitable for adult migrants with little or no 
previous training or qualification.  

You do not have to do all the steps described, but you can do e.g. steps 
1-6 or 1-7.Tips
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Story and Truth 

Objective
To reflect on one's own situation and share it with others, finding 
possible solutions for dealing with barriers and obstacles. 

Competences 

involved

Oral Storytelling 
Dealing with language 
Active listening 
Creativity 
Self-reflection 
Appreciation

Description, 

Step by Step

1. Work with the pictures (see unit 2) and ask the participants to find a 
picture that tells them about something that prevents them from 
doing what they want to do; something that is a barrier in their life.  

Back in the circle, everyone can show the photo they selected, and 
explain what their barrier is.  

2. Ask how each of them deals with it in the real world. Be open to 
questions from other participants.  

3. Place each photo on the floor in a circle in the middle.  
4. Start a round of “once upon the time there was a … “ (who is this 

person we will tell about? Where does she/he live? Every day that 
person …. (what did that person do every day?) But one day …? 
(What happened one day?) Because of that …?  

The facilitator repeats everything, so every story is heard. 

Telling true stories about barriers can make the barriers visible and make 
it possible to deal with them. In the exercise we start with real life and 
with something that everyone can identify with. We end with stories that 
are fiction and thus create a safe place for dealing with the situation. 
The learners can tell something about someone who is not themselves. 
They can be free and open-minded in their story. This opens the group 
for experiments, new thoughts and solutions.

Learning 

Outcomes

Participants will: 
• reflect on their own obstacles and barriers and look for possible 

solutions or a way to deal with them. In exchange with the group 
solutions can be found together 

• express themselves and experience that they can talk about their 
personal obstacles.

Additional 

comments

Can be transformed with many different themes by varying the 
questions. E.g. ask to select a photo that represents certain feelings, like 
happiness, home, family,…
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Storytelling photos, black-and-white pictures, postcards

Material

1 hour

Duration

Circle 
Black and white photos (storytelling photos) that are distributed on a table or 

the floor.
Setting

Create confidence in the group. Be active and ask questions to understand 
and deepen the topic. Thank everyone.

Tips

www.listen.bupnet.eu 0!46



 

 

www.listen.bupnet.eu 0!4702

Promoting intercultural  
understanding 

Background and activities



Food for thought 

“All living cultures are outcomes of intercultural communication. Human history is the tale 

of such journeys. This becomes particularly evident in the globalization era where the 

ever-fast evolving cultural landscape is characterized by an intensified diversity of 

peoples, communities and individuals who live more and more closely. The increasing 

diversity of cultures, which is fluid, dynamic and transformative, implies specific 

competences and capacities for individuals and societies to learn, re-learn, and unlearn so 

as to meet personal fulfilment and social harmony. The ability to decipher other cultures 

in fair and meaningful ways is predicated not only on an open and pluralistic spirit but 

also on self-cultural awareness. When a culture is critically aware of its own strengths and 

limitations, it can extend its horizons and enrich its intellectual and spiritual resources by 

learning from alternative visions in epistemology, ethics, aesthetics, and 

worldviews.”  (UNESCO 2013: Intercultural Competences. Conceptual and operational 

framework, p. 4) 

General objectives of the module and overview of units: 

The UNESCO framework (p. 24) presents a list of skills and competences understood as 

the basic requirements to attain intercultural competences. These are: 

• Respect (“valuing of others”); 

• Self-awareness/identity (“understanding the lens through which we each view the 

world”); 

• Seeing from other perspectives/world views (“both how these perspectives are 

similar and different”); 

• Listening (“engaging in authentic intercultural dialogue”); 

• Adaptation (“being able to shift temporarily into another perspective”); 

• Relationship building (forging lasting cross-cultural personal bonds); 

• Cultural humility (“combines respect with self-awareness”) 

In LISTEN we are convinced that storytelling is a perfect means to promote these skills 

that enable us to live together peacefully and respectfully, regardless of our ethnicity or 

nationality. From the list above we can see how intercultural competence and storytelling 

are deeply connected, as they both build on the same attitudes and skills. This may be 

because of the ancient roots storytelling has in all cultures across the world (as described 

in module 1), or because of the way our brains work, or both. In any case: Storytelling is 

all about human encounter and interaction on a deeper than rational level, about sharing 

and understanding. Listening to others’ stories or sharing our stories with others, makes 

us open up and more easily identify with the other. In Module 1 we have elaborated 

Storytelling as method for learning and understanding under different aspects.  
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In this module we present complementing methods that focus on intercultural 

understanding and competences, beyond the focus on storytelling. It is divided into two 

units: one that addresses trainers and describes activities with which educators can reflect 

on their intercultural understanding and their role in intercultural groups. The other unit 

presents activities that can be used by trainers to foster intercultural understanding in 

learners groups. 

Even though this module is designed to support trainers carrying out educational 

activities with refugees, the activities described can be applied with other target groups 

too.  

•  Unit 1 – Promoting intercultural competences of learners 

•  Unit 2 – Promoting intercultural competences of trainers 

Learning outcomes 

After reading and studying this module, you will be able to implement activities that will 

enhance the following: 

• Knowledge of terms, cultural features and different cultural backgrounds  

• Skills to address different beliefs and ideas within groups and to work with 

individuals with diverse cultural backgrounds 

• Reflective skills to examine one’s own practice, attitudes and beliefs and to enhance 

intercultural sensitivity  
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Unit 1 – Intercultural competences  

for learners 

Introduction 

People either are competent jointly, or are incompetent, but there is no such thing as one 

person being interculturally competent alone. Only through joint construction of a 

relationship in which people listen to one another can individuals demonstrate their 

intercultural competences. Intercultural dialogue, the process of holding conversations 

among members of different cultural groups, whereby individuals listen to and learn from 

one another, serves as the essential starting point. Knowledge of the other does not 

ensure friendship or liking, but can reduce the chance of perceiving “others” only in terms 

of broad and inaccurate stereotypes. (UNESCO, p. 38) 

Objectives 

Most refugees come from countries very far away and start a new life in Europe in a very 

different context than in their country of origin. They bring diverse backgrounds and 

experiences, possess a variety of strengths, and tackle considerable challenges as they 

adjust to their new lives in Europe. When you are working with refugees and migrants it is 

important to invest time and energy in learning more about their backgrounds, interests, 

aspirations and needs. The language barrier shall not prevent communication, and some 

basic tools can help people to communicate anyway and to understand each other better. 

The activities in this unit shall help: 

• To better understand each other;  

• To reflect about culture and its imprints in everybody; 

• To overcome barriers of speaking a foreign language; 

• To understand critical situations and how to deal with them constructively. 

Overview of learning activities 

1. I tell you my name 

2. My object, my culture 

3. World Map 

4. The bridge 

5. Camping 

6. Forum theatre 
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I tell you my name 

Objective
To get to know each other; to share different personal and cultural 
aspects of the learners’ names

Competences 

involved

Self-awareness and self-expression 
Communication (in a foreign language) and listening 
Relationship building and intercultural understanding

Description, 

Step by Step

In this activity, the participants are invited to share the story of their own 
name, its history and its meaning. 

A good setting is to sit in a circle so everyone can see and hear well. 

On a flipchart visualise some questions to help participants understand 
in which way to tell the story their name: 

• Who chose your name and why? 
• Does it have a meaning? 
• Was it always like this or has it changed? 
• Do you like your name? 
• How do your relatives and friends call you? 

As trainer you may start and give an example by telling the story of your 
name. 

Learning 

Outcomes

The participants will: 
• gain self-awareness 
• develop self-expression and active listening 
• get to know each other better and develop confidence 
• be able to identify commons and differences and to address these

Additional 

comments

If you have time left, you can invite every participant to write his/her 
name on a paper and next to each letter of the name something typical 
for him/her, starting with the corresponding letter. It could be a 
characteristic, hobby, a person etc. Then everyone presents his/her 
ideas to the rest of the group.

Flipchart with questions

Material

Approx. 3 min. per story, overall duration depending on the number of 
participants

Duration
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My object, my culture 

Circle of chairs

Setting

If you are working with a large group and have limited time then 
participants can work in small groups. 

Encouraging participants to draw, rather than write, takes the pressure 
off those who are less able in terms of reading or writing.Tips

Objective
To stimulate confrontation and reflection towards one's own and others 
cultures

Competences 

involved

Self-perception and self-reflection 
Communication (in a foreign language) and active listening 
Intercultural understanding

Description, 

Step by Step

Participants are invited to bring with them an object or a photo that 
represents their culture or an aspect of it. 

Sit in a circle, the objects are put in the middle. 

Everyone then presents to the rest of the group what he/she has 
brought, specifying what it represents and why it was chosen. 

After each participant introduced the object, leave the floor for them to 
exchange about it. Questions for discussion may be, if anyone sees 
similarities or has associations, or questions about specifics of the 
objects, etc.  

At the end ask the participants what they found interesting or surprising 
during the activity.

Learning 

Outcomes

Participants will: 
• acquire greater awareness of different cultures and their 

expressions  
• reflect and share their own culture 
• get to know each other better 
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World Map 

Objects, or photographs of the objects brought by the participants.

Material

Approx. 5 minutes per participant

Duration

Participants will sit in a circle, so everyone can see the different objects.

Setting

You can ask the following questions while the participants present their 
objects. 

Has it been difficult to choose an object, a picture? 
Why did you choose this object? 
Why is it typical for your culture?

Tips

Objective
By learning from where the participants come, the group will better 
understand them and their cultural background.

Competences 

involved

Self-perception  
Self-reflection 
Communication and active listening 
Intercultural understanding

Description, 

Step by Step

The trainer introduces the goal of the activity. By using a world map and 
post-its, they identify: 

• Country where they lived and share it to the group. Each 
participant writes their name on a post it and sticks it on their 
country on the map. 

• Common countries of origin, historical connections and cultural 
commons between countries  
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The bridge 

Learning 

Outcomes

Participants will: 
• practice communication 
• locate countries on a map 
• share their national and cultural background 
• build relationships 

Additional 

comments

This activity can lead to many stories. Depending on the willingness of 
the group to share and the time you have, you can also use the exercise 
to talk about why and how people came here.

A map of the world, post-its, pens

Material

Min. 15 minutes, depending on number of participants.

Duration

The participants are standing in a semicircle in front of the world map.

Setting

Participants should be asked if they are ready to talk about their countries and 
how they left them. If you have chosen this path, be careful not to interrupt the 

session after 5 minutes.
Tips

Objective
To show that communication can be difficult when speaking a different 
language, but is still feasible.

Competences 

involved

Team building 
Conflict resolution and decision making 
Communication (in a foreign language)  
Relationship building and intercultural understanding
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Description, 

Step by Step

Two groups will be formed and will represent two villages of two different 
communities. 

The trainer will instruct the inhabitants of each "village" to build half of a 
bridge over a very large river that separates the two communities. 

Participants will have 20 minutes to do so. 

To construct half of the bridge, each village will be placed in two different parts 
of the room so as not to influence the activity, teams cannot see each other. 

After 5 minutes from the start of the activity the trainer will lead one or two 
members of a group to the other group's room and vice versa. 

They will become migrants and will have to follow special rules to simulate 
language difficulties and differences between the two cultures. 

The activity will end with a test of bridge stability (it should be large enough to 
cover the width of the river and strong enough to support a glass of water). 

Instructions for the two groups: 

You are on one of the banks of a 50 cm wide river. Together with the villagers, 
who are on the other side of the river, you have agreed to build a bridge. Each 
village is responsible for building one half of the structure (thus being able to 
cover half the width of the river bed: 25 cm). 

The communication between the two villages is extremely difficult, because 
you don't speak the same language. 

For the moment, you can only start building your half of the bridge: it must be 
ready in 20 minutes and then will be welded to the other half. 

Once the bridge is completed, engineers will test the structure: the bridge will 
have to bear the weight of a glass filled with water placed in the centre of the 
structure. 

Rules for the “migrant”: 

You are a migrant: you are about to migrate to the new village and, once you 
arrive, you will find yourself in a new context, never seen before, in contact 
with a population that has a different culture from yours. Once you arrive in the 
new village, you will not be able to speak or respond to members of the 
original community, because you will not know their language. You can, 
however, express yourself in gestures and respond to those who use non-
verbal language.

Learning 

Outcomes

The participants will: 
• develop teambuilding skills 
• deal with problems and increase their problem solving competences 
• experience diversity and learn how to deal with it
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Camping 

Cartons, pens, white sheets, scissors, sticky tape 
2 plastic glasses filled with water 

Rules
Material

30-40 min

Duration

6-16 people divided in two teams. Sitting is better in order to build the bridge.

Setting

At the end of the activity, the trainer will ask questions: e,g,  
How did you work within your groups? How did you overcome the 

disagreements? 
How did you act when you met the first migrants?  

How did you feel as a migrant?

Tips

Objective To show effective ways of communication and practice active listening

Competences 

involved

Effective communication (in a foreign language)  
Active listening

Description, 

Step by Step

Participants will be divided into two groups. 

There is one speaker in each group. 

In both groups the speaker begins to read a list of 20 objects that a couple 
going camping would need. The other group members try to remember as 
many items as possible. 

The group 1 narrator (transmission) reads the list aloud and tells the other 
group members what the couple needs. The group is not allowed to ask 
questions, only to listen. As soon as the narrator is finished, the group 
members write down each of the things they can remember. They then 
compare their results and discuss whether they would take these things with 
them.  

In Group 2 (Communication), the group members discuss the things that a 
couple would need for camping. After the speaker has read the list, the group 
briefly discusses whether the list is complete or whether something is missing 
or everything is really necessary. Again, a list is made of the things the group 
members remember and the results compared. 

At the end the partners of group 1 and 2 show their lists of things and the 
results are compared.
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Forum theatre 

Learning 

Outcomes

The participant will be able to: 
• improve quality on communication competence; 
• analyse the meaning of the words “transmission” and communication”, 

the differences existing between them and the potential effects of both 
concepts on the learning process; 

• improve transversal skills, such as: self-reflection, listening, empathy

Additional 

comments

During the evaluation, you can help with flipchart and markers to pinpoint 
strengths and critical points of communication dynamics.

List of 20 objects

Material

30-40 min

Duration

4 to 20 participants 
Participants will work in 2 groups in two different rooms/spaces

Setting

At the end the trainer will ask for comments and feedback to both groups, 
reflecting on the two modes of exchange and communication, then on 

unidirectional transmission and two-way communication, asking what can be 
improved and how it is influenced by external dynamics.Tips

Objective To provide tools for change and conflict resolution 
To explore and transform situations of discomfort, malaise, conflict, 
oppression.

Competences 

involved

Conflict resolution 
Self-expression and self-reflection 
Communication and active listening
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Description, 

Step by Step

Participants are asked to tell a story about a conflict situation they have 
personally experienced or seen. 

The teacher asks the participants if they are ready to perform their stories. 

Some stories are selected and the conflict is staged as a play by some 
volunteers.  

If no stories are found, you should have some conflict situations ready as case 
studies that can be staged instead.  

After a first performance, the scene will be repeated and spectators will be 
invited to take part, replacing the protagonist to try to change and improve the 
situation presented at the beginning. 

The trainer will have the task of facilitating public interventions. There are no 
debates or discussions: the public can only intervene by taking the stage 
instead of the actors, offering their solutions in absolute freedom. 

Changes can lead to the resolution of the conflict or to the occurrence of an 
obstacle that prevents progress: In this case the trainer will stop the scene and 
restart it from where it was interrupted, so that spectators can intervene again. 
The solutions proposed must be possible and realistic.

Learning 

Outcomes

The participants will: 
• Better understand conflict situations 
• Create problem solutions 
• Engage with the group 
• Express themselves and their ideas

Sheets describing the conflict situation.

Material

50 min

Duration

Min 3 participants,  
standing.

Setting

In conclusion, the group can discuss about the confrontation and the solutions 
found in relation to real life problems.

Tips
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Unit 2 – Intercultural competence for trainers 

Introduction 

When you are working with refugees and migrants it is really important to invest time and 

energy in learning more about their backgrounds, interests, aspirations and needs. This 

unit focuses on the learning process of educators and which mindsets and attitudes it 

needs, in order to work with culturally diverse, and often vulnerable groups.  

Firstly we present a number of definitions and principles, to better understand what 

interculturality is and how it can be operationalised in education. Following two workshop 

activities for trainers are presented, in which they can reflect on interculturality, their role 

in culturally diverse groups and their own cultural lens through which they perceive and 

interpret what is happening.  

Theoretical basis 

Some definitions 

“The term multicultural describes the culturally diverse nature of human society. It not 

only refers to elements of ethnic or national culture, but also includes linguistic, religious 

and socio-economic diversity. 

Interculturality is a dynamic concept and refers to evolving relations between cultural 

groups. It has been defined as “the existence and equitable interaction of diverse cultures 

and the possibility of generating shared cultural expressions through dialogue and mutual 

respect”. 

Interculturality presupposes multiculturalism and results from ‘intercultural’ exchange and 

dialogue on the local, regional, national or international level.”1 

Looking at research a number of recurrent principles can be identified that may guide 

action in the field of intercultural education: 

• Principle 1: Intercultural education respects the cultural identity of the learner 

through the provision of culturally appropriate and responsive quality education for 

all. 

• Principle 2: Intercultural education provides every learner with the cultural 

knowledge, attitudes and skills necessary to achieve active and full participation in 

society.  
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• Principle 3: Intercultural education provides all learners with cultural knowledge, 

attitudes and skills that enable them to contribute to respect, understanding and 

solidarity among individuals, ethnic, social, cultural and religious groups and nations. 

These principles are directly related to the third pillar of education: “Learning to live 

together”, which consists in “developing an understanding of other people and an 

appreciation of interdependence – carrying out joint projects and learning to manage 

conflicts - in a spirit of respect for the values of pluralism, mutual understanding and 

peace. This is also closely related to the provisions of the Universal Declaration of Human 

Rights, which mentions that the aim of education should be to “promote understanding, 

tolerance and friendship among all nations, racial and religious groups”. 

Objectives 

This unit intends to support trainers in intercultural settings: 

• To better understand learners from diverse cultural backgrounds and tailor support 

to their needs and perspectives; 

• To analyse own cultural perspective and expectations; 

• To help participants to bond with each other; 

• To go beyond mere tolerance of another’s culture and customs in order to enhance 

creativity, challenges and differences into new forms of expression. 

Overview of learning activities 

1. What does intercultural competence mean for trainers 

2. Cross-cultural checklist for trainers 

What does intercultural competence mean for trainers 

Objective

This activity is designed to be carried out with a group of trainers, working in 
an intercultural context. Together they define the concept of intercultural 
competence and what it implies for their attitude as trainers.

Competences 

involved

Self-reflection and self-awareness 
Asking and listening

Description, 

Step by Step

The activity is divided in 2 parts: 

First, in groups, the participants will establish a list of the 7 minimum 
requirements to obtain intercultural competence. 

Then they report their requirements supplemented with their personal and 
professional experiences to the entire group. You may use cards and stick them 
on a board to collect all statements.
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Description, 

Step by Step

The respective competences defined by the UNESCO deliver the framework 
for the collection and subsequent discussion: 

• Respect (“valuing of others”); 
• Self-awareness/identity (“understanding the lens through which we each 

view the world”); 
• Seeing from other perspectives/world views (“both how these 

perspectives are similar and different”); 
• Listening (“engaging in authentic intercultural dialogue”); 
• Adaptation (“being able to shift temporarily into another perspective”); 
• Relationship building (forging lasting cross-cultural personal bonds); 
• Cultural humility (“combines respect with self-awareness”). 

In a second round the participants will answer the question: What elements 
ensure good training with culturally diverse groups? 

Again, use cards and have the participants collect them on a board while 
sharing their thoughts with the group. 

The following answers are anticipated: 

• Knowing yourself and your role: (who you are, come from) as the trainer is 
the captain of the boat 

• Offering activities that create cohesion and trust among the groups: “the 
group dynamics” 

• Managing and controlling time and space respectfully and properly  
• Keeping participants motivated: make sure they have fun 

Finally, you can look at the collected answers together and reflect on specifics 
and rankings.

Learning 

Outcomes

The participants will: 
• know how to communicate with other cultures, but also how to work 

effectively with them. 
• gain increased awareness of the trainer's role in his/her environment.

Additional 

comments

If you want to learn more about intercultural competences, we recommend the 
extensive UNESCO publication: https://en.unesco.org/interculturaldialogue/
resources/132 

Flipchart, pens, cards

Material

45 min depending on number of participants

Duration
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Cross-cultural checklist for trainers 

Participants work in pairs.

Setting

All answers can be accepted, but if those on the list have not been given, 
explain them and underline why they are important in a training with 

intercultural groups
Tips

Objective

Individuals can demonstrate a wide range of values and preferences across a 
variety of cultural dimensions: communication patterns, space perception, time 
perception, gender views and beliefs etc.  

How much do trainers know about their participants, their cultural backgrounds 
and countries they come from?

Competences 

involved
Self-reflection and self-perception

Description, 

Step by Step

Give each participant a pen and a copy of the “Cross-Cultural Checklist” and 
ask them to work through each question reflecting about their own culture. 
The questions should be answered from their own cultural background and 
perspective. Allow 10 min for the exercise. 

In the second round the participants answer the same questions from the point 
of view of refugees and migrants – would they answer the questions in the 
same way or not? Are there differences that can lead to differences of opinion 
or even conflicts? Why, why not? Allow 15 minutes for this.

Learning 

Outcomes

By answering the questions of the "Intercultural Checklist", participants are 
encouraged to reflect on their own perceptions and those of their learners and 
to discuss them. They change perspectives.

Additional 

comments

This activity is designed to enable the target group to identify what they know 
(and don’t know) about another culture or country. 

You may add additional questions to the list, if you want to more specifically 
focus on certain aspects of culture.

Cross-Cultural Checklist consisting of 9 questions (see next page), pens

Material
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Approx. 30 minutes

Duration

Ideal for a multi-cultural group. 
Participants are sitting in a circle.

Setting

Ask the participants about their spontaneous feelings and comments.  
Encourage them to share their experience and what they have gained after the 

activity.
Tips

YES NO I DON’T KNOW

Is it better to keep emotions private or to 
express emotions openly?

Do you prefer to address differences when 
there is an issue, so the problem can be 
solved quickly? Or do you rather deal with 
differences indirectly, behind the scenes?

Is it more important that the group is 
satisfied, or the individual?

Should the focus be on the relationships 
rather than on plan of action?

Do you like to be on time and expect it from 
others?

Is it okay to talk to everyone in the same way 
or is it better to adapt to factors like their 
age, gender etc.?

Do you believe in fate?

Do you work because you want to or 
because you need to?
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Recording and 
broadcasting stories



Food for thought 

Stories help to connect. In a classroom setting or when people sit together to exchange 

stories, the effect is immediate, but limited to the persons present. As LISTEN aims to 

support the integration of refugees to their host societies, we also focus on ways how to 

share stories with a broader public and broadcasting via radio or internet is a suitable 

means for that, as it is accessible and not necessarily connected with monetary costs, 

given that some basic equipment is available. In this module we have focused on how this 

can be achieved with tools that are broadly available. 

General objectives of the module and overview of units: 

In storytelling on the radio the voice telling is emphasised. In this context it is the only 

medium to convey meaning and emotion to the audience. Other than stories that are 

shared in a face to face situation, environment, body language of the teller and the 

chemistry of the audience are less relevant. Thus when recording a story, it is helpful to 

pay attention to this reduction and to give plenty of space for practice, recording and 

playback so you have the opportunity to become familiar with the story to be told and the 

specifics of the medium.  

This module has a different structure than the other ones. It is not organised in activities, 

but aims to enable trainers to facilitate recordings and broadcasting of stories that 

evolved in their courses. Thus we don’t present activities to carry out with the group, but 

rather guidelines how to achieve good recordings and how to broadcast them to the 

world or a selected audience in various ways. 

The module is divided in four units: 

• Unit 1 – Basics of sound recording  

• Unit 2 – Recording stories  

• Unit 3 – Editing audio files  

• Unit 4 – Broadcasting stories  

Learning outcomes 

At the end of this module, you will: 

• Understand the technical basics of sound recording 

• Be able to record stories using a smartphone or computer 

• Be able to edit recordings using free software on a computer 

• Know how to broadcast stories in various ways 

• Know where to find further information and tools 
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Unit 1 – Basics of sound recording 

Introduction 

Accessible technology for capturing sounds has evolved considerably in recent decades. 

From tape recorders with cable bound microphones to mobile phones, from analog to 

digital - what was once an exclusive field of professionals has become a technology, 

accessible for everyone. 

Some people still use analog recording, but in our context we will focus on digital 

recording. Digital recording is nowadays the most common, cheapest, and easiest 

method of capturing sounds. It is also a technology that is easily accessible for everyone 

with a computer or smartphone and can be done without any investment in technical 

equipment. With free software and apps, everyone can record, edit and broadcast 

sounds. 

Sound recording can be fun, exciting, hectic, tiresome, laborious and unforgiving. But 

with some basic knowledge and following a few guidelines, a huge difference can be 

achieved between amateurish and well sounding production. 

Objectives 

• Understand the basics of sound recording  

Practical Guidelines 

Recording equipment 

The simplest setup for recording sound would be a microphone, cable/lead and a sound 

recorder. Connect the microphone via cable to the recorder and voila! Of course, there is 

a lot more to it, and professional recording sessions are much more complicated. But the 

basic principles stay the same. Let’s have a quick look at the basic three components of 

the setup. 

Microphone 

There are a lot of heavy, big books on microphones. But to have a good understanding of 

the subject we can distinguish two  types of microphones: dynamic and condenser. 

Condenser microphones are bit more sensitive than the dynamic ones. You can use them 

to record vocals in the studio, and a wide range instruments such a piano or violin.  

For most of us, the microphones in our mobile phones and our laptops are more than 

likely enough to get by, but if available an external microphone can also be used. 
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Cables/Leads 

If you record with a computer or a smartphone, you probably won’t need any extra 

cables. But in case you aim for a professional recording in a studio, most common cables 

you will find there to connect a microphone to the recorder are so called “XLR balanced 

connectors”. They can carry the sound over a long distance without inducing any 

unwanted noise. And finally USB cables that connect a microphone to the computer are 

also common. 

Sound Recorder 

Anything that can capture a sound is a sound recorder. A mobile phone with a respective 

recording app is the most common one, which we recommend, as presumably most 

people will have one and it is also easy to use. Alternatively a simple old fashioned stereo 

recorder can be used, but most likely the quality will not be comparable to modern digital 

devices. For digital recording and editing we recommend a programme called Audacity, 

which is for free and easy to use, while producing satisfactory results. We will come back 

to that in Unit 2 and 3. 

Recording techniques 

Techniques for recording audio are an art in itself. Factors for success are the choice of 

equipment, the placement of the microphone, or the settings for recording levels. These 

are only a few variables that determine the outcomes. Every recording requires a different 

approach, depending on location, number of people in the room, surrounding noises and 

the purpose of the recording. It is important to have an open mind but also a good 

knowledge of basic procedures. You may experiment with different set ups to see how the 

outcomes vary, e.g. by trying different devices, or spatial arrangements in the recording 

situation. Like in everything experimenting and learning from mistakes is a great thing. 

But there are a few standard rules that you should apply if you want your recording to 

sound awesome. 

Be wise when choosing the microphone – it can mean a great difference to a general 

sound of your recording. If you don’t have professional equipment at hand, you may ask 

your learners to try out their recording devices on their smartphones and then decide 

together which device delivers the best results. 

Microphone placement 

Remember the last time when you had to raise the volume on your smartphone or 

computer to the maximum to listen to that Youtube video? Or maybe you had to turn it 
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right down because it was way too loud? This can be tackled with the right distance 

between microphone and speakers, and the recording settings of your recording device.  

A quiet recording will result in a noisy recording. Turn the volume up, but record  too 

loud and the distortion will ruin your work. 

Always record more than you need 

If you create several audio files or longer versions of a story, you will have more options to 

choose the best parts from the material afterwards. Also important: When editing the 

material, never edit the original recording but make a copy, so in case something goes 

wrong, you have a backup of the original. 

Do a test before and listen back to it  

Before starting to record the story, we recommend to do some tests in order to assess the 

best settings in regard to placement and settings of the equipment. It is always better to 

get it right at the beginning rather than trying to correct it later on. After you have your 

take on the story, directly listen to it again, and see, if you feel ok with it or whether 

something needs to be improved.  

Experiment and have fun with the process. Besides your own activities, it also helps to 

listen carefully to any kind of audios, to get a feeling for quality and your own needs. The 

more you learn hands on, the better your recordings will sound in the future.  
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Unit 2 – Recording stories 

Introduction 

As mentioned in the previous unit, audio recording is a science for which professional 

equipment is available. In order to keep our approach open and easy to use for anyone, 

in the following we will focus on recording audios with smartphones, as it is presumably 

the most wide spread tool anyone has with them and can work with. This way the 

threshold to include the recording part in your storytelling activities is low. Among other 

functions a smartphone has the capacity to connect with the internet, to take photos and 

videos, to connect with computers, download applications, write notes and record audio.  

You can use your smartphone (same as with other technologies) as an audio recording 

device to:  

• Record stories  

• Add spoken words to slideshows, which is a great alternative to video as it can be a 

lot more intimate, and easier to control  

• Capture a moment in sound  

For the editing part afterwards, you might want to transfer your audio files to a computer, 

as the screen is larger and it’s easier to manage files. 

Objectives 

• Learn to record sounds  

Practical Guidelines 

How to record audio on a smartphone 

Most smartphones have default installations to record audios. If you are satisfied with its 

quality, just use this. If you feel you need another solution for recording, we recommend 

downloading the programme “Audacity”, as it can both record and edit. After you have 

had a look, how the recording device works, you are almost set to start. 

Before starting the recording, identify where the microphone is positioned on your 

smartphone. For most smartphones the mic is at the bottom of the phone. Remember to 

point this end of the phone towards the subject or sound you are recording.  

• Get a better sound by adding an external microphone to your smartphone.  

• If you don’t have a mic - don’t panic! Get up close to your subject.  
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Tips for recording audio 

• Close down all other apps on your phone. Because of radio waves the input might 

get distracted and may sound noisy afterwards. Turn on airplane-mode before you 

start.  

• Make sure you’ve tested your smartphone and audio recording apps and are familiar 

with how to use them.  

• Charge your phone and have the charging cable nearby, just in case. Don’t forget 

your headphones.  

• Location: Think about a place where your storyteller will feel comfortable, where you 

won’t be interrupted and where there won’t be too much other sound in the 

background. A café can be a bad place to record a story (too much sound) and even 

parks can be noisier than you think.  

• Avoid windy areas: especially if you are using the internal smartphone’s mic. An 

alternative could be to do the recording in a parked car as a mobile insulated audio 

booth.  

• Record 1-2 minutes of pure background sound (atmos) – no talking. This is 

invaluable later on when you come to edit.  

• Place the mic end of your smartphone close to your subject.  

• For recording your own voice: Some headphones have built in mics like the iPhone 

headphones. This is useful for recording your voice while on the move.  

• Check your levels, meaning the average voice level of the voice you are going to 

record. These levels are visualised by the recording software following the traffic 

light system. Green means ok, red is too high. Record the person talking and make 

sure the levels are moderate, not high. This usually means around the –12db mark – 

but the most important thing is to make sure you’re not going in the red zone. If you 

can’t see anything happening, then there won’t be any sound. Play it back to check if 

it’s all there and everything is working well.  

Exporting the recorded audio from your phone onto your computer 

Connect your smartphone to your computer using a USB connection. Depending on the 

brand of the phone, it should appear like a flash drive on your desktop. Simply click on 

the drive to find the audio files contained within. If you use your own computer, another 

option is to just synchronise it with your smartphone. A third option to transfer the audios 

to a computer is to email them as an attachment. In this case you should check the file 

size before, to make sure the file is not too big to be sent. Finally some smartphones can 

connect to computers via Bluetooth. If you want to use this method, make sure you have 

Bluetooth switched on your phone and your computer. 
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Prepare for editing 

Next, import your audio file into an editing program on your computer. On some 

computers there are default installations, like Windows Movie Maker, that can be used. 

Alternatively a range of free software is available that deliver good results. We 

recommend the programme Audacity, as it combines several functions (e.g. recording and 

editing), it is easy to use and delivers high quality results. Another recommendation is the 

programme Garageband. 

Of course it is also possible to edit the file on your smartphone directly. There are a 

number of free apps available.  
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Unit 3 – Editing audio files 

Introduction 

The aim of this unit is to learn how to edit an audio file. To achieve this objective, we are 

going to import an existing sound file, remove superfluous parts, apply a fade-out at the 

end, export the results, and play it in any audio player. These are the basic steps 

commonly used when editing the contents of an audio file. Even though instructions in 

this unit relate to the programme Audacity, the steps of the procedure and technical 

settings are same or similar with other tools. 

Objectives 

• Learn to edit audio files 

Practical Guidelines 

Import a file into Audacity 

First launch Audacity. Then import an audio file by selecting File >  Import > Audio and 

then select the file you want to edit in your explorer window. An alternative and quicker 

method is to just drag and drop the file into the editing interface of Audacity. 

Interpret what you see 

The image below shows a stereo waveform as it is displayed in audacity. The left stereo 

channel is in the top half of the track and the right stereo channel in the bottom half. The 

track name takes the name of the imported audio file. Where the waveform reaches closer 

to the top and bottom line of the track, the audio is louder (and vice versa). The ruler 

above the waveform shows you the length of the audio in minutes and seconds. 
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Navigation and basic functions in Audacity 

The image below shows the so called Transport Toolbar. Click the Play button    to listen 

to the audio. Click the Stop button    to stop playback. On a computer you can use the 

Space key on the keyboard as a shortcut for Play or Stop.  

 

If you want to listen only to certain parts of the recording, click on Selection Tool  then 

click on the waveform to choose a place to start, then click the Play button    .  

Click at the point where you wish to start and drag the pointer until the end of the section 

you are interested in. Now you have marked a selection in the file, and when you now 

click the Play button    , only this selection will be played.  

You edit audio waveforms in Audacity in much the same way as you would edit text in a 

word- document. When you are editing text you first select the text you want to change 

and then choose what you want to do with it. You might want to cut or copy the text, 

delete it, paste new text in its place, or change it to bold. You do the same thing in 

Audacity: first zoom and select the range of audio you want to change, and then choose 

what you want to do with it. Even the navigation icons are similar. 

The image below shows the Edit Toolbar with the Zoom buttons highlighted. This     is the 

Zoom In tool, and this      is the Zoom Out tool. 

To zoom in and to get a closer look at the waveform, first choose the Selection Tool , then 

click near the point you're interested in, then click the Zoom In button. Keep clicking the 

Zoom In button until you see the detail you need. Note that when you click the Zoom In 

button the cursor is centered on the screen. 

There are also menu commands and keyboard shortcuts for zooming. View > Zoom > 

Zoom In (or Ctrl + 1) is the same as clicking the Zoom In button. View > Zoom > Zoom 

Out (or Ctrl + 3) is the same as clicking the Zoom Out button. View > Track Size > Fit to 

Width (or Ctrl + F) will zoom the waveform so it fits in the window. 

Use the Zoom commands so that you can make maximal use of your Audacity window to 

see as much detail as you need, or to make sure you see the entire file when necessary. 

Cut out superfluous parts 

In many cases you will have superfluous material in your recording, which you will want to 

delete in the final version. This may be the silence in the beginning before the story starts, 
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a repetition in the text, or the words of relief after the telling. You may have a time limit 

and want the story shorter, etc. To cut an audio file according to your needs, follow these 

steps: 

1. Listen to the entire piece and write down the time stamps of the parts where you 

feel editing to be necessary. For example: the story starts at second 17, before it is 

only background noise. Or in minute 1:23 the speaker gets confused until min 

1:34, when he carries on with the story. 

2. With playback stopped, click near the point where you want the piece to begin. 

3. Zoom in to better see the Timeline, which helps you to navigate to the right points 

in time.  

4. While holding down the Shift key, mark the track right of the cursor. (Note that this 

is just like selecting a range of text in a word document.) 

5. Press Space to listen to the entire selection. Playback will stop when the end of the 

selection is reached. 

6. Adjust the start and end of the selection with the mouse as follows:  

7. Move the pointer over the start of the selection - the cursor will change to a left-

pointing hand. Click and drag to adjust the beginning of the selection. 

8. You can adjust the end of the selection in a similar manner. 

9. Press Space to listen to the adjusted selection. You do not have to listen to all of it; 

press Space again at any time to stop playback. 

A convenient way to listen to only the adjusted start of the selection is to move the 

mouse pointer a little after the start of the selection then press B. The selection plays from 

the start of the selection to the pointer. To hear the adjusted end of the selection, move 

the pointer close to the selection end, then press B to play from the pointer to the 

selection end. 

You can also play a length of audio either side of the selection by pressing C. This lets you 

make sure there is no audio you want to keep that will be removed. Playing either side of 

the selection would also be useful if you later wanted to cut a small piece out of that 
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selection - you would select the small piece to be cut, then could preview how the audio 

would sound after the cut. 

You've now selected the portion of the audio that you want to keep. Make sure you have 

pressed Space to stop if the track is still playing, then to delete everything except the 

selected audio, click on Edit > Remove Special > Trim Audio. 

If you make a mistake, you can always click on Edit > Undo. Audacity has unlimited Undo 

and Redo steps. You can undo your editing actions all the way back to when you 

imported the file. You can also Redo actions that you have undone. 

Fade in and fade out 

If you have trimmed your audio according to your needs, you might want to do some final 

fine tuning. Fading in and out is very common when audios are broadcasted, e.g. on the 

radio. It just sounds better, if an audio file doesn’t start or end abruptly, but fades in or 

out. Here’s how you can do that with Audacity. The explanation below refers to fading 

out, but fading in is done in the same way, just with the respective command, which is 

found in the same menu as fade out. 

1. Click the Skip to End button  . 

2. Zoom In until you can see the last few seconds of the waveform. 

3. Click in the waveform about 5 second before the end. 

4. Click on Select > Region > Cursor to Track End. 

5. Click on Effect > Fade Out. The last five seconds of the audio is smoothly 

faded out. 

The fade out effect sounds even better, when you do the procedure twice. The first time 

apply fade out to a relatively short period, and in a second round you repeat the 

procedure with a longer piece (e.g. first round with 5 seconds, second round with 8 

seconds). 
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Tip 

Note that you always select the audio track you want to edit first, and then choose what 

action you want to perform on it. 

Export the final audio file 

When you save an Audacity project via File > Save Project you are doing just that - saving 

an Audacity project. Audacity projects can be opened only by Audacity. If you want other 

applications (such as iTunes or Windows Media Player) to be able to open this file you 

need to export it. 

Before we export our audio clip to a different file format we're going to simplify things a 

bit. Go to the Import / Export Preferences, and under “When exporting tracks to an audio 

file” uncheck "Show Metadata Editor prior to export step". Metadata Editor adds extra 

information about the speech or music into the file - see “For More Information below” to 

learn more. You can go back to the Import / Export Preferences at any time to re-enable 

Metadata Editor. 

You cannot open an Audacity project in a media player. Only by exporting your project 

can you listen to it in a media player. WAV (Waveform Audio File Format) is a Microsoft 

and IBM audio file format standard for storing an audio bitstream on PCs. For most media 

players WAV is a standard audio file format. Another common audio file formats are mp3, 

AAC and WMA. The procedure is the same for any format, just select your favorite format 

in the drop down menu when exporting your file. If you are interested to find out about 

the differences of audio formats, please refer to the further reading section at the end of 

this module. 

1. Click on File > Export > Export Audio... - the standard "Save" dialog for your 

operating system appears. 

2. Give the file a different name. Audacity always suggests a name for the file that is 

the same as the name of your Audacity project. It is always best to alter this so you 

do not confuse your exported file with your Audacity project. 

3. Choose a location to save the file in the usual manner. 

4. At the bottom of the Save dialog is a dropdown menu labeled "Format". From this 

menu choose "WAV (Microsoft) signed 16-bit PCM". 

5. There are no options for the WAV file format, so there is no need to click the 

Options button. 

6. Click the Save button to complete the export of your project to a WAV file. 

Once you've exported your project you may want to keep the original project file (AUP) 

and its associated data folder, in case you want to make some changes to it in the future.  
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Unit 4 – Broadcasting stories 

Introduction 

In this unit we present ways to share stories publically. There are many different ways to 

do so. In LISTEN we have focused on broadcasting stories via the radio, but of course it 

cannot be presumed that everyone has this possibility. In the following we present two 

other ways to broadcast stories to the world, easily accessible and free of costs. One is 

live broadcasting via facebook, the other one gives you an overview how to set up your 

own free internet radio station. 

Objectives 

• Learn to broadcast stories via different media 

Practical Guidelines 

Broadcasting live on Facebook 

Anyone can make their own live-stream. Creating and streaming live content might sound 

like a challenge, but setting up a live-stream within Facebook’s mobile app is a fairly 

straightforward process. 

Step 1 

The first step to setting up a live-stream is to launch the Facebook app on your 

smartphone. From the News Feed tab, locate the Live button just below the “What’s on 

your mind?” section at the top of your display. (Note: The screenshots below are from the 

iOS version, but the steps also apply to Android.) 
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Step 2 

Next, tap either the “Live button” or the “What’s on your mind?” field at the top, the 

latter of which will bring up a host of additional options including a “Live Video button”. 

Step 3 

If this is your first time live-streaming content via Facebook, the app will ask for 

permission to access your device’s camera and microphone. You’ll want to grant 

permission; otherwise, you won’t be able to stream video from your device. You will then 

be lead through the process by the platform itself. 

Step 4 

Once the introduction has concluded, 

you can get started. Describe your 

contribution at the bottom of your 

screen and, if desired, geotag your 

location or tag other Facebook users 

in your live-stream. Here, you can 

also add other information to your 

live-stream, including your mood. 

This is also where you can adjust your live-stream’s privacy settings as you can choose 
who can view your video. You can even choose the “Only Me” option if you want to test 
recording a live-stream and don’t want anyone to watch just yet. 

When everything is set up, press 

the blue “Go Live” button in the 

lower-right corner of the screen to 

share your scene with the world or 

your selected audience. When 

you’re finished, simply tap “Finish” 

to end the stream. Facebook will 

automatically save and publish the 

video on your profile page so that 

anyone who missed it can watch it 

later. You can also change privacy 

settings to control who can see the video, or remove it entirely if you no longer want it to 

appear in your feed. 
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Broadcasting via your own internet radio station 

Of course, there are alternatives to Facebook. Sharing stories via an online radio station is 

another way, and less difficult than one might think, neither in terms of equipment nor in 

regard to competences and formal procedures. Unlike terrestrial radio, you do not need 

to actually own a license in order to broadcast your stream online. Getting a license is 

only necessary if you plan to play commercial music. As there are a number of repositories 

with open license music pieces, this should not be a hurdle. Further below we present 

some links to databases where you can find a large selection of free music.  

Following we give an overview of what is needed and which steps are to be taken in a 

general way. As there are so many different tools and also formats the station can get, we 

focus on giving an overview, rather than going into details. Instead we provide a number 

of links to tutorials and tools that will help you on the way, which you find under further 

reading. 

Equipment 

Setting up an internet radio station is do-able, not even a lot of expensive equipment is 

needed. You just need a standard computer or laptop, an internet connection, and a 

microphone. It’s even possible to get away with a built-in mic. When you’re first starting 

out it’s better to use the equipment you have and upgrade at a later stage. 

Broadcasting services 

With the equipment in place, it’s time to focus on finding a service provider. A stream 

hosting provider will give you a platform to upload your automated playlists and/or 

broadcast your content live. Whether you’re new to internet radio and need a simple 

solution or you’re an experienced professional scouting for the next best alternative, there 

are plenty of choices - from easy “click and broadcast” to complex solutions. You’ll need 

to figure out what you want to get out of your online station, research a few providers, 

and pick the one that best meets your needs. Under further reading we present a few 

hosting services which are offered free of charge.  

Broadcasting 

Once you have chosen a provider that fits your needs, and have installed the respective 

software on your computer, you can start to produce or share your content with the world. 

There are two options how to broadcast your contents: live or automated. Automated 

means you prepare a playlist which can be automatically played according to your 

schedule. Concrete technical instructions of course differ, depending on the service you 
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have selected. Usually each platform also offers instructions how to use it, so we won’t go 

into detail here. Internet radio providers offer a bunch of different methods how you can 

give listeners access to your stream; it might be a player on your website, via mobile apps 

(iOS and Android), and on directories or third-party places you can define yourself. 

Podcasts as alternative 

Depending on the type and amount of content you want to produce, creating a podcast 

can be an easy alternative to put out digital audio content on a regular schedule. People 

can follow your podcast and listen at their leisure. Most podcasts are in MP3 format and 

shared either through iTunes, Mixcloud, Soundcloud, or all of these, and can also be 

embedded into websites. The advantage of a podcast is that many people are already 

familiar with the format and follow other podcasts. When you post a new podcast, it will 

send out notifications to your followers. 

Tutorials and hosting services 

Below you find some useful links to articles, tools and media for your broadcast. 

Internet radio station hosting 

http://www.listen2myradio.com/  
https://www.serverroom.net/radio/  
https://myradiostream.com/  

Tutorials 

https://radio.co/radio-university/  
https://live365.com/blog/how-to-start-an-internet-radio-station/  
https://www.wikihow.com/Create-an-Internet-Radio-Station  
https://blog.bufferapp.com/podcasting-for-beginners  

Free music 

http://freemusicarchive.org/  
https://www.bensound.com/royalty-free-music/2  
https://www.premiumbeat.com/royalty-free-music  
https://incompetech.com/music/royalty-free/music.html  
http://ccmixter.org/  

Further reading 
Audio formats compared: https://www.makeuseof.com/tag/audio-file-format-right-needs/  
How audio file formats differ and what this means for listeners. MP3, AAC, WMA, FLAC, 
ALAC, WAV, AIFF, and PCM explained: https://www.lifewire.com/different-types-of-music-
files-3134920  
Audacity: Complete tutorial guide to Audacity for beginners: https://www.youtube.com/
watch?v=aCisC3sHneM  
The Audacity manual: http://manual.audacityteam.org/  
Some really good tips on how to edit audio files: https://www.buzzsprout.com/learn/
audacity-tutorial  
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Assessing and evidencing 
competences acquired 
through applied storytelling 



Food for thought 
Storytelling is an excellent approach to enhance learners’ competences – accessible to 
everyone, as all of our lives are made of stories. Migrants and refugees can specifically 
benefit from storytelling because they can learn and practice the new language of their 
host country in creative and intuitive ways. Through storytelling methods we develop 
many competences, not only linguistic ones. Becoming aware of this progress increases 
the learning effect and helps to communicate the own competences towards others. In 
this module we present the LEVEL5 method to assess and evidence competence 
developments gained through applied storytelling for learning, be it as trainer or as 
learner. The validation approach LEVEL5 makes it possible to assess, visualise and 
document these competence developments, unfolding formative effects. It also includes 
issuing meaningful credentials.  

General objectives of the module and overview of units: 

This module sets the grounds and raises awareness for the purposes and benefits of 
validation of competences gained through applied storytelling. It introduces the LEVEL5 
method and addresses a number of aspects that are worth considering when assessing 
competences of migrants and refugees, including assessment methods suitable for 
different settings. The overall aim of the module is to guide you through the application 
of LEVEL5, either to assess your own learning progress as trainer in terms of using applied 
storytelling in your work, or to apply the method with your learners. 

• Unit 1: Introduction to validation of learning outcomes 

✴Background knowledge: Basic terms in the field of validation 
• Unit 2: Using LEVEL5 to validate competences 

✴Introduction to the validation system LEVEL5: principles and procedure 

✴The LISTEN inventory of competences 
✴Learning activity: self-assessment exercise 

• Unit 3: How to support refugees and migrants in assessing their competences 

✴Learning activities: Developing an assessment concept. Self-reflection on the 
own target group, comparison with a collection of experiences and 
considerations 

Learning outcomes 

After studying this module you will be able to: 
• explain the relevance and impact of validating competences developed through 

storytelling,  
• define and differentiate the most frequent terms in the field of competence 

development and validation, 
• describe the characteristics of LEVEL5  
• apply LEVEL5 in a self-assessment  
• apply LEVEL5 with migrants and refugees  
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Unit 1 - Introduction to validation of learning 

outcomes 

Introduction 

Validation aims to make visible and value the full range of an individual’s qualifications 

and competences, irrespective of where these have been acquired. Learning outcomes 

are statements of what a learner is expected to know, understand and/or be able to 

demonstrate after the completion of a process of learning. Different terms in the context 

of validation are being used and with different purposes. Hence we would like to 

introduce a few definitions on which our development work is based.  

In this unit we give some basic information on the most important terms related to 

validation of learning outcomes and its purpose and benefits for both the learner and the 

trainer. 

Objectives 

• To become familiar with different terms and definitions in the context of validation 

• To discover the benefits of validation 

Some background knowledge 

What are competences?  

A competence refers to someone’s ability to do something successfully; competences 

blend knowledge, skills and attitudes applied in a particular situation on a particular 

quality level. Our competences are dynamic: they grow and become transferrable – i.e. 

they can be learned and developed in one context and used in many other social and 

employment contexts. If we don’t use them, they decrease. 

What is the difference between evaluation, assessment and validation? 

Evaluation is the process of observing and measuring a thing for the purpose of judging 

it and determining its ‘value’ or ‘worth’, generally by comparison to an agreed standard. 

Assessment involves a process of observing or measuring the effectiveness of something. 

‘Summative’ assessment measures the end-point: how well the learner has done or how 

much the learner has achieved. A ‘formative’ assessment is done for the purpose of 

improving the impact of a learning activity through reflection and feedback. It is learner-

centred, course-based and not graded. 
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“Validation is the process of identifying, assessing and recognising a wider range of skills 

and competences which people develop through their lives and in different 

contexts…“ (CEDEFOP, European Centre for the Development of Vocational Training and 

the number 1 for validation related matters at European level). The objective is to make 

visible and value the full range of an individual’s qualifications and competences, 

irrespective of where these have been acquired. 

What is the difference between formal, non-formal and informal learning? 

Formal learning follows a syllabus and is intentional in the sense that learning is the goal 

of all the activities learners engage in. Learning outcomes are measured by tests and 

other forms of assessment. 

Non-formal learning takes place outside formal learning environments but within some 

kind of organisational framework. It arises from the learner’s conscious decision to master 

a particular activity, skill or area of knowledge and is thus the result of intentional effort. 

But it need not follow a formal syllabus or be governed by external accreditation and 

assessment. 

Informal Learning takes place outside schools and colleges and arises from the learner’s 

involvement in activities that are not undertaken with a learning purpose in mind. Informal 

learning is involuntary and an inescapable part of daily life; for that reason, it is sometimes 

called experiential learning.  5

Purpose and benefits of validation 

Validation arrangements can be of benefit to all citizens and help combat unemployment 

by improving skills matching and social cohesion. Validation can offer crucial support to 

the unemployed or those at risk of losing their jobs by enabling them to show the value of 

their skills and experiences either to potential employers or when returning to formal 

education. Validation can also form part of the response to the current refugee crisis 

through identification, documentation, assessment and certification of migrants’ previous 

experiences, to support quicker and smoother integration into host countries. For 

individuals that need to redirect their careers, validation can open a door to new 

occupations. It can also play a major role in combating youth unemployment by making 

skills acquired through voluntary work, or during leisure, visible to employers.  6

 Definitions taken from Council of Europe: https://www.coe.int/en/web/lang-migrants/formal-non-formal-5

and-informal-learning (visited on 05.09.2018)

 European guidelines for validating non-formal and informal learning, CEDEFOP, 20156
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In general, the benefits of introducing validation in adult education and learning can be 

situated at: 

• educational level: improved access and transfer in education, exemption of training 

or subjects, partial/full awards; 

• economic level: makes human capital visible, addresses skills shortages, supports 

employment;  

• social level: access to education/employment for the disadvantaged;  

• personal level: self-esteem, confidence, motivation, possible greater access to 

employment/promotion, stimulating self-reflection on prior and further learning. 

Valuable competences, frequently developed through informal and non-formal learning, 

are rarely validated and certified by learning providers. This leaves a huge amount of 

progress and development that cannot be demonstrated or proven to potential 

stakeholders. Therefore, validation represents a considerable opportunity for migrants, 

refugees and those people working with them. 
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Unit 2 Using LEVEL5 to validate competences 

Introduction 

One approach to validate competences acquired in non-formal and informal learning is 

LEVEL5 – a system that has been developed and piloted in a series of European-funded 

projects by several partners of the LISTEN consortium since 2005. LEVEL5 offers an 

approach and instrument to assess, visualise and document competence development. In 

this unit you will learn how to apply LEVEL5 in order to visualise your own or your 

learners’ competence development.  

Objectives 

• To become familiar with the LEVEL5 validation system specifically designed for 

assessing and evidencing learning outcomes in informal and non-formal learning 

and the inventory of competences 

• To practically apply LEVEL5 for  

• yourself and for  

• your learners 

Introduction to the LEVEL5 system to evidence competence 

developments 

LEVEL5 is a unique system to validate competences and competence developments and 

to create learning environments and pathways in non-formal and informal learning 

contexts. It is especially suitable for personal, social and organisational competences that 

form the backbone of the European framework of key competences.  7

The framework states that a “competence“ is the ability to apply a synthesis of 

• knowledge, 

• skills and 

• attitudes 

in a particular situation and with a particular quality”. 

Since the age of the enlightenment we know by the works of the Swiss pedagogue 

Pestalozzi that learning happens with "head, heart and hand". In recent years 

 The “Key Competences for Lifelong Learning – A European Framework”: http://eur-lex.europa.eu/legal-7

content/EN/TXT/?uri=URISERV:c11090 
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neurobiological (brain) research has again clearly demonstrated that the non-cognitive 

dimensions are of special importance for learning. 

The LEVEL5 methodology is based on these notions. Consequently, the LEVEL5 system is 

based on a model to assess, evidence, and validate the cognitive, activity related and 

affective competence developments (cognition, actions, values) in informal and non-

formal learning contexts. Individual or group competences are evaluated in a process-

orientated way and, if desired, visualised in a three-dimensional cube model and fully 

documented in a specific software system. 

LEVEL5 focuses on learning processes as they represent potentials, too. For this reason 

two assessments are foreseen: the first one at the beginning of a learning activity and the 

second one at a later stage after a certain period of practice. When comparing the results 

of the two assessments you will be able to see the extent to which a competence evolves.  

The LEVEL5 cube visualises developments of knowledge, skills and attitudes on five 

quality levels. These levels are defined through reference systems – the core of the 

LEVEL5 system. A reference system describes a given competence on five levels in each 

competence dimension – from beginner to competent expert. These reference systems 

are adaptable to different target groups and learning contexts. 
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The LISTEN inventory of competences 

Using storytelling as method in education or recording and broadcasting creative 

achievements, be it as trainer or learner, one develops skills and competences. Each 

learner develops differently through the various impulses these activities unfold. One may 

master a language, the other may discover a talent for technical tasks.  

Below we present a set of competences that trainers should have or should develop when 

they want to use applied storytelling with their learners. In addition, a second set of 

competences is dedicated to learning through storytelling itself, and that is at the same 

time relevant for learners to reflect on and become aware of their learning, as there is a 

certain demand from society to possess these competences, e.g. teamwork or 

communication skills. 

In LISTEN we percieve the follwoing competences are essential for trainers when 

implementing storytelling based training and/or recording and broadcasting: 

• Applying storytelling in learning settings 

• Assessing learners’ training needs, demands and motivations  

• Intercultural communication 

• Motivating and empowering learners 

• Facilitating recording and broadcasting of stories with learners 

These competences are more transversal and relate to areas of development for 

participants in storytelling activities. Even though they were selected based on the 

relevance they have for refugees and other disadvantaged learners, they are applicable to 

everyone. 

• Storytelling in a foreign language 

• Teamwork 

• Dealing with diversity 

• Creativity 

• Self-esteem 

Each competence is described for the LISTEN context and then substantiated with 

descriptors for related knowledge, skills and attitudes. The respective LEVEL5 reference 

system, based on which assessment and rating can be carried out, can be downloaded 

from our website under Validation. 
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Applying the The LEVEL5 procedure 

The LEVEL5 approach is based on a five-step procedure:  

Step 1: Describing the learning project  

The learning activity and context is described in terms of its background, goals, learning 

activities, expected impact and aspired competences. This information is  necessary to 

generate meaningful learners’ certificate at a later stage, if this is desired.  

Step 2: Selecting competences 

Competences are chosen from the inventory above corresponding with the learning 

activity. Competences or competence-sets can be chosen for group learning projects or 

can be tailored specifically for an individual learner. The LISTEN inventory including the 

reference systems is available on our website (www.listen.bupnet.eu) under Validation. 

Step 3: Contextualising a reference system 

A reference system describes a competence in an abstract way. If needed, it can be 

contextualised to specific learning settings, either by tailoring the general learning 

outcome descriptions to the setting, or by defining specific indicators for the respective 

competence levels.  

Step 4: Assessment 

Assessment concepts (self-, external and mixed assessment) and methods should be 

chosen according to the context and objectives of the learning setting. A catalogue of 

assessment instruments is also available on our website. (M4.2_LISTEN catalogue of 

Assessment methods for refugees.) 

Step 5: Rating/documenting/visualising  

Competence developments will be assessed and rated with the help of the indicators or 

by individual reasoning through examples given by the learner or assessor. The individual 

progressions can be documented in the web-based LEVEL5 software. Based on this data 

individual learners’ certificates can be generated that visualise the development. 

Please note that you do not have to use the LEVEL5 software. All steps can also be taken 

offline. For further information please contact level5@bupnet.de  

In order to make the procedure more practical we invite you to reflect on and assess your 

own competence development while applying the LISTEN approach. For this purpose 

please go to the annex where you find self-assessment sheets for two exemplary 
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competences: Rating and documenting learning outcomes with LEVEL5 and Storytelling 

in a foreign language. In addition we provide further instructions on our website under 

Validation (M4.2_Self-assessment guidelines).  

We have also prepared a case study that illustrates the use of LEVEL5 with a group of 

migrant women who took part in a training course for long-term unemployed women. 

One of the trainers carried out a learning project with them called “Culturally diverse 

women on air – making radio with a group of migrant women”. You will find the case 

study on our website. Please read the case study and then go through the LEVEL5 

process. 

Additional Material available on the LISTEN website 

• Case study on the practical application of LEVEL5 with refugees and migrants 

• Catalogue of assessment methods  

• Inventory of competences and reference systems 
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Unit 3: How to support refugees and migrants 

in assessing their competences 

Introduction 

Assessing competences fosters self-reflection and stimulates the learning process. Before 

starting, there are some aspects that you should think about: what is your target group, 

what are the aspired learning outcomes, which competences are enhanced in your course 

and can be assessed, and which assessment methods are suitable for the setting. As every 

group is different you will come to different answers to these questions. There is no one-

fits-all solution. 

Specific objectives of the unit 

After studying this unit you will be able  

• to assess competence developments of and with your learners with the LEVEL5 

method. 

Learning Activity: How would you assess the competence 

developments of your learners? 

When you think about your group of migrants and/or refugees, how would you assess 

their competence developments? Which assessment methods would you choose? If you 

are not sure, you can use the questionnaire (M4.3_ Questionnaire assessment concept in 

the annex) to note down your answers to the following questions. 

You should consider the following aspects for selecting appropriate assessment 

method(s): 

• How is the language knowledge and level of the migrants and refugees you are 

working with? 

• How would you explain to your learners what competences are and what 

competence development is? 

• Which competences would you choose to assess with your learners? 

• Which methods would you use with your learners to support them in assessing their 

competences? 

• Would you opt for self-assessments (and support them, if needed) or would you do 

the assessment for/with them? 
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Guidelines how to use LEVEL5 with refugees and migrants 

Assessing competence development 

When you wish to apply LEVEL5 with refugees and migrants, there are some aspects that 

you should pay more attention to than with other target groups, e.g. because of the 

language as limiting factor. This is a short summary of the experiences that we have made 

so far when working with this target group. 

You should make learners familiar with the general concept of LEVEL5 and the purpose 

and benefit of involving them in some activities to reflect on the development of their 

competences. Depending on the level of language proficiency and educational 

background, you should reduce theoretical background information to the absolute 

minimum. Too much theoretical background is rather confusing than helpful in this 

context. Nevertheless, learners need to understand what you are doing when assessing 

their competences. Try to use simple words for this purpose. Say for example “We would 

like to look at your learning development.” Or “We are interested in what you have 

learned.”  

It is also essential to think about the setting in which you are doing the assessment. 

Carefully think about who should be present in this situation (and who should rather not 

take part). A safe and trustful atmosphere is very important. Migrants and refugees who 

have experienced many critical questions from the host country’s administrations are often 

careful in what they say about themselves and might be hesitant to reveal personal 

information especially when it comes to sensitive issues.  

Create a motivating, interactive and participative environment. Support and motivate the 

learners throughout the entire process. Let them know they can get in touch with any 

questions or queries they might have. It can also help to communicate clearly that the 

assessment is not a test and that the results do not count for anything but serve reflection 

purposes and that the use of the results is in their hands. You should make it very 

transparent and clear what will be done with the results. 

Carefully choose your assessment method taking into consideration your target group 

and your time budget. If you are not able to use self-assessment grids because of 

language barriers then you should go for an alternative assessment method. We present a 

variety of assessment methods for different conditions in our catalogue of assessment 

methods, available on the LISTEN website. 

When asking questions, especially about your learner’s feelings, be prepared that this can 

bring emotions to the surface. Migrants and refugees might have gone through a stressful 

time or even have to cope with trauma. Depending on their current situation they are 
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most likely to suffer from fears and doubts about their past and their future. This might 

come up in an interview situation. You should think about how to deal with this and have 

some strategies for calming the situation. You should be empathetic with the person 

concerned at the same time.  

Finally you should also be sensitive to reflect on your own attitude towards the learners. 

What about your own prejudices? Is there a distance between you and your learners? Do 

you feel that they are very different from you? Are you reluctant to ask certain questions 

because you are afraid to break taboos or intimate them? You have to find a good 

balance: migrants and refugees are people like you - they deserve to be treated as 

normal as any other human. On the other hand they are sometimes more vulnerable than 

others and this has to be taken into account without discriminating them. 

Our recommendations in a nutshell 

• Use simple words and questions. 

• Avoid terms such as “LEVEL5”, “reference systems”, “categories”, ... . 

• Tell your learners why you do assessments. Point out that the idea is to document 

and make their learning and competence development visible for themselves. 

• Only assess one, maximum two competences. 

• Be aware that not every assessment method is suitable with every competence and/

or with your participants. Choose the competence and the assessment carefully. 

• Create a comfortable setting for your assessment 

Creating certificates 

With LEVEL5 it is possible to create certificates that visualise the learner’s development in 

chosen competences. It is evident that creating certificates is a free choice and that your 

learners must agree to it. Explain to them that the certificate can be used as tangible 

evidence for job search or for further education in the future – highlight the practical 

benefits of the certificate.  

Point out that, even if your learners do not intend to share their certificate, they can find 

concrete phrases to describe their competences, e.g. in informal talks with potential 

employers, at job fairs or in interviews. 

Ideally, hand out the certificates during an event that involves also other members of the 

organisation. Refugees and migrants will feel more motivated to valorise the 

competences acquired through the learning project and use their certificate in the future. 

You can include a small awarding ceremony during an event in your organisation or plan a 

small event in this sense. An example of such a certificate is also available on the LISTEN 

website under Validation. 
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Annex 

M4.2 Exercise: Self-assessments with LEVEL 5 for trainers and learners 

One way to assess competences with LEVEL5 is through self-assessment directly related 

to a LEVEL5 reference system.  

Below we present two self-assessment worksheets, one for trainers to assess their 

competence on  “Rating and documenting learning outcomes with LEVEL5”. The other 

one addresses the competence “Storytelling in a foreign language” and can be used by 

both, trainers and learners. 

The LEVEL5 method foresees to assess a competence at two points in time, usually at the 

beginning and at the end of a learning activity, like a course. Based on these two ratings a 

certificate can be created that documents the development.  

Please use the table to rate your own competence at the beginning of your learning 

phase and come back to the table when you will have finished to do the second rating.  

The material is structured as follows: It starts with a full reference system, describing the 

competence for the three dimensions on 5 levels for each dimension. Please read this first 

to gain an overall picture of the competence, before you start reflecting about your own 

competence level in each dimension. 

On the subsequent pages you will find each of the three dimensions on one page with 

additional columns, where you can indicate and reason your rating. 

More competences described in LEVEL5 reference systems can be found in the LISTEN 

inventory of competences. 
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Reference System: Rating and documenting learning outcomes with LEVEL5 
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KNOWLEDGE Dimension: My knowledge concerning “Rating and documenting 

learning outcomes with LEVEL5” 

How to fill this grid: 1. Read the level titles and descriptions. 2. How would you rate 

yourself at the beginning and at the end (tick 1 box at the beginning and 1 box at the 

end) 3. Give concrete examples of what you knew at the beginning and at the end and 

write them in the 2 boxes behind your ticked ones. 
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Level 5: Constructing, transferring to different contexts, i.e. into private life, other fields/contexts 
Level 4: Self-directed acting (researching, expanding options, i.e. related to learning content/
topic, …) 
Level 3: Acting partly independently, choosing between options, selecting 
Level 2: Imitating, Acting without own impulse, acting when being instructed 
Level 1: Listening only, participating only, reception without action…



LEVEL5 Reference System: Storytelling in a foreign language  
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My knowledge for Storytelling in a foreign language before and after the LISTEN 

training 

How to fill this grid: 1. Read the level titles and descriptions. 2. How would you rate 

yourself at the beginning and at the end (tick 1 box at the beginning and 1 box at the 

end) 3. Give concrete examples of what you knew at the beginning and at the end and 

write them in the 2 boxes behind your ticked ones. 
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12 Level 5: Constructing, transferring to different contexts, i.e. into private life, other fields/contexts 
Level 4: Self-directed acting (researching, expanding options, i.e. related to learning content/topic, …) 
Level 3: Acting partly independently, choosing between options, selecting  
Level 2: Imitating, Acting without own impulse, acting when being instructed 
Level 1: Listening only, participating only, reception without action…



My skills to tell stories in a foreign language before and after the LISTEN training  

How to fill this grid: 1. Read the level titles and descriptions. 2. How would you rate 

yourself at the beginning and at the end (tick 1 box at the beginning and 1 box at the 

end) 3. Give concrete examples of what you knew at the beginning and at the end and 

write them in the 2 boxes behind your ticked ones. 
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M4.3 Questionnaire: Conceptualising the assessment of competence developments 

with refugees and migrants 

Question Your answer

How is the language 
knowledge and level of 
the migrants and 
refugees you are working 
with?

How would you explain 
to your learners what 
competences are and 
what competence 
development is?

Which competences 
would you choose to 
assess with your 
learners?

Which methods would 
you use with your 
learners to support them 
in assessing their 
competences?

Would you opt for self-
assessments (and 
support them, if needed) 
or would you do the 
assessment for/with 
them?
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Recommendations from 
the national pilot projects



The LISTEN partners have extensively documented their experiences and results in the 
implementation of the LISTEN approach in many different learning projects during the 
practical phase of the project. These results are published in the European Experience 
Report, which is available in English on the LISTEN website. In the following sections we 
present some relevant recommendations based on partners’ feedback from the practice 
phase and underpinning the tips given in the previous chapters. We have structured the 
recommendations according to the main elements of the LISTEN approach: storytelling, 
intercultural understanding and integration, recording and broadcasting, assessment and 
validation of competence developments. 

Storytelling with intercultural groups 

• Create a good atmosphere within the group. Put some effort into teambuilding at 
the beginning. – We recommend that you really take the time to build up a 
relationship of trust and respect within the group and have a lot of fun doing so. It is 
important for the continued work and to reduce the sense of uneven status and 
prestige. 

• The space is important: Find or create a cosy place to do the storytelling. Involve the 
learners if the room is still to be arranged - this creates the feeling that it is their 
space. 

• When learners sit in a circle, this is a good starting point because everyone can be 
seen, can act and feel safe when surrounded by others. 

• Awareness of the situation of refugees definitely helps to understand them better. 
Respect the needs and sensitivities of your group members and be sensitive to 
cultural barriers, e.g. when talking about specific issues in mixed-gender groups. Ask 
your group if you are not sure. 

• Everyone has a story to tell, if you can create the conditions for storytelling. But 
some people need more time to open up, while others are ready to tell from the 
beginning. Imagine it is a process that gains momentum over time. 

• It is important to have enough time for the process! Give time to everyone to open 
up and to become heard, and seen.  

• Find some questions that you can ask at the beginning. Questions help people to 
start talking. The questions should be open and start with: WHAT, WHERE, WHEN, 
WHEN, WHO, HOW or Tell me.... And give time to listen.  

• Objects to talk about, songs and music support the opening of the group and help 
to foster creativity and the willingness to narrate and interact in the group. 

• Don't just focus on telling stories, but emphasize that listening is just as important. 
Be a good listener, too.  

• Empathy is an important competence in listening to stories, for the trainers and also 
for the participants. 
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• Make it possible for everyone to participate and be successful. Avoid building 
pressure. 

• Be well prepared and always open to improvisation. Be open-minded and curious 
about what the participants will share. Listen with all your senses. Be present. Be 
personal, but not private. Be a friend and companion. Don´t be afraid of tears, of 
crying.  

• Appreciate each effort made by the participants. Make it possible to laugh and feel 
free. Make it possible for everyone to use their body and their voice to 
communicate. Language is communication between people – a teller and a listener.  

• Do not force anyone to tell a story in public. Also don’t push people to tell personal 
stories if they are not ready. Everyone should be free to decide how far they want to 
go.  

• Storytelling in a group may become personal, but that’s what it is about. Don’t focus 
on potential crisis, e.g. by anticipating that participants are traumatised. Try to take 
people as they are and trust that telling, even of difficult situations, can turn into 
relief and new strength. A good group can bear almost anything together. 

• Do not be afraid of changing conditions, be open to what you can and cannot do. 
Change allows you to learn new methods and new tools. And rely on the 
competence of the group.  

• An interpreter in the background, who can intervene in case of language barriers, 
helps the trainers to overcome language problems. If no external interpreter is 
available or affordable, participants can be asked to volunteer to help other group 
members. 

• If you work in a group where there are new participants in almost every session, you 
will have to find a way to present the learning process you have started. One way is 
to draw a timeline and show what has been done and where you are now. 

Promoting intercultural understanding and integration 

• If you want to promote integration, create meeting places were diversity is normal, 

where exchange and cooperation is important, and where stories are shared. In 

many places public events called Storytelling café or Story evenings take place, 

where people from different cultures, backgrounds with different experiences come 

together to tell their stories and to listen to each other.  

• Storytelling is a good opportunity to reach out to other stakeholders and 

organisations and involve them in your work, whether through information, visits or 

joint activities. It arouses interest and curiosity, and storytelling activities can also be 

used to build new contacts and networks. 
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Recording and broadcasting 

• If technical activities are to be included in the storytelling project, it might be helpful 

to dedicate additional training time to the technical preparations and for participants 

to perform some tests themselves.  

• As a trainer, you should first test the intended instruments and be sure how to use 

them so that you can instruct the group.  

• Ask your group if someone has an affinity for technology. If they agree they can 

become technical assistants who support the others.  

• It is easier to record stories in a small group to have less background noise and be 

more focused.  

• Ask the participants if they agree to publish their story and if so, help them to find a 

good platform to broadcast the story, e.g. on the local radio or through podcasts on 

a website.  

• When recording a story, a microphone can have a very inhibiting effect – prepare 

your learner for it and allow time for the process. 

Assessing and evidencing competence developments 

• As far as validation is concerned, it is important to choose an appropriate method 

for assessing learners' competence development. For learners with low language 

skills, interactive methods can be used that do not require intensive conversation but 

encourage them to express their learning outcomes in a playful way. 

• Reflection on learning outcomes contributes to the positive impact of storytelling 

activities by making learning more conscious. But depending on the learners’ 

language level, some creative methods are needed. In any case, it must be properly 

planned and takes time to be useful. 

• For learners with better language proficiency or who wish to demonstrate their 

competences for concrete purposes such as job search, we recommend organising 

individual interviews with learners to better reflect on their competences. In this way 

the process is more focused than in a group. Calculate at least half an hour per 

participant. 

• Start by giving concrete examples of what the competence to be assessed means. 

• Use the reference system to formulate interview questions in a simple language. 

Working directly with the reference system is too abstract. 
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